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ABSTRAK

APLIKASI PEMBELAJARAN AKSARA JAWA BERBASIS
MULTIMEDIA

WENDI AFRIANTO, NIM 07.12.573
Dosen Pembimbing : Irmalia Suryani Faradisa, ST, MT
Sotyohadi, ST

Bangsa Indonesia merupakan bangsa besar yang terdiri dari banyak suku.
Salah satu suku yang ada di Indonesia adalah suku Jawa. Suku Jawa memiliki
banyak budaya, diantaranya adalah penggunaan aksara Jawa sebagai media
komunikasi dalam bentuk tulisan yang saat ini mulai dilupakan. Bentuk aksara
dan seni pembuatannya menjadi suatu peninggalan yang patut untuk dilestarikan.
Dalam upaya ikut menjaga peninggalan budaya ini dan dengan memanfaatkan
teknologi komputer, maka dapat dihadirkan suatu aplikasi pembelajaran aksara
Jawa yang berbentuk multimedia interaktif dengan menggabungkan teks, gambar,
animasi, dan suara.

Aplikasi pembelajaran aksara Jawa berbasis multimedia ini meliputi cerita
Ajisaka atau cerita asal usul terciptanya aksara Jawa, cara penulisan dan
pembacaan aksara Jawa, penerjemahan huruf latin ke aksara Jawa atau aksara
Jawa ke huruf latin, latihan dan tes yang berupa soal — soal seputar aksara Jawa.

Dengan adanya aplikasi pembelajaran aksara Jawa berbasis multimedia
ini diharapkan dapat membantu seseorang untuk lebih mengenal dan mempelajari
aksara Jawa, berlatih menuliskan aksara Jawa dengan mudah, dan mengukur
kemampuannya mengenai aksara Jawa melalui fasilitas yang telah disediakan
pada aplikasi ini.

Kata kunci : Pembelajaran, Aksara Jawa, Multimedia
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BABI
PENDAHULUAN

1.1 Latar Belakang
Bangsa Indonesia merupakan bangsa besar yang terdiri dari banyak suku

bangsa. Masing-masing suku bangsa ini memiliki kebudayaannya sendiri-sendiri.
Bukti-bukti yang ditemukan menunjukkan bahwa sudah sejak lama, bangsa
Indonesia mengenal kebudayaan dan menjadi bangsa yang berbudaya. Kekayaan
berupa kebudayaan ini harus dijaga agar tetap terpelihara dengan baik.

Salah satu suku bangsa yang terdapat di Indonesia adalah suku Jawa
dengan kebudayaannya yang sering dikenal dengan budaya Jawa. Budaya Jawa
memiliki banyak aspek. Salah satunya adalah penggunaan aksara Jawa dalam
komunikasi dengan media tulisan. Untuk menjaga kelestarian budaya yang berupa
aksara Jawa ini, tentu diperlukan usaha-usaha pelestarian. Seperti bentuk
kebudayaan yang lain, usaha-usaha pelestarian dilakukan dengan menjaga dan
memelihara bentuk fisik dari budaya itu sendiri, dalam hal ini adalah naskah-
naskah literatur Jawa.

Sebagai media komunikasi, khususnya komunikasi tulisan maka cara
yang dapat dilakukan untuk melestarikannya adalah dengan menggunakan aksara
Jawa ini sebagai media komunikasi dalam kehidupan sehari-hari. Untuk dapat
menggunakan aksara Jawa ini sebagai media komunikasi tulisan, tentu menuntut
adanya kemampuan untuk membaca dan menulis aksara Jawa itu sendiri secara
baik dan benar sesuai aturan yang berlaku. Hal itu dapat dilakukan dengan
mempelajari buku-buku yang ada di pasaran. Namun terkadang mempelajari
aksara Jawa melalui buku terkadang kurang menarik dikarenakan kurang atraktif
dan monoton. Salah satu cara untuk membuatnya menarik adalah dengan
memanfaatkan teknologi komputer sebagai media belajar.

Dengan berkembangnya teknologi komputer terutama dalam bidang
perangkat lunak yang makin pesat, sangat mendukung dalam penerapannya
sebagai media pembelajaran. Dalam mengupayakan dan menjaga peninggalan
budaya tersebut, maka dapat dibuat suatu media pembelajaran tentang aksara Jawa



dengan memanfaatkan teknologi komputer.

Pembelajaran dengan pemanfaatan komputer sebagai media belajar ini
diharapkan dapat menghadirkan bentuk pembelajaran aksara Jawa yang menarik
karena media pembelajaran tersebut dapat memuat materi pembelajaran secara
tekstual, audio maupun visual.

Berdasarkan latar belakang tersebut, maka peneliti berkeinginan membuat
”Aplikasi Pembelajaran Aksara Jawa Berbasis Multimedia” untuk mempermudah
dalam mempelajari aksara Jawa.

1.2 Rumusan Masalah
Berdasarkan latar belakang di atas, maka dapat diambil permasalahan
yaitu bagaimana merancang dan membangun suatu aplikasi pembelajaran aksara

Jawa yang mudah dalam penggunaanya dengan desain aplikasi yang menarik.

1.3 Tujuan

Sesuai dengan rumusan masalah tersebut maka tujuannya adalah untuk
membantu seseorang lebih mengenal aksara Jawa dan berlatih menuliskanya
dengan mudah, serta mengukur kemampuannya memahami aksara Jawa melalui
soal - soal yang diberikan dengan desain tampilan aplikasi yang menarik.

1.4 Batasan Masalah
Agar permasalahan mengarah sesuai dengan tujuan yang diharapkan, maka
pembahasan dibatasi oleh hal - hal sebagai berikut :

1 Hanya membahas mengenai aksara Jawa yang meliputi cerita Ajisaka,
aksara carakan beserta pasangan, sandhangan, aksara swara, aksara rekan,
angka Jawa, dan tanda baca.

2 Tidak membahas mengenai bahasa Jawa.

Soal - soal latihan dibuat secara statis dan tidak menggunakan database.
4 Penerjemahan dari latin ke aksara Jawa berdasarkan tulisan bukan ejaan _



1.5 Sistematika Penulisan
Untuk mempermudah dan memahami pembahasan penulisan skripsi ini,

maka sistematika penulisan disusun sebagai berikut :

BABI

BAB II

BAB III

BABIV :

BABV

: Pendahuluan

Berisi Latar Belakang, Rumusan Masalah, Tujuan Penelitian,
Pembatasan Permasalahan, dan Sistematika Penulisan.

: Landasan Teori

Berisi tentang teori - teori yang berhubungan dengan penelitian
yang dilakukan.

: Analisa dan Perancangan Sistem

Dalam bab ini berisi mengenai analisa kebutuhan sistem baik
software maupun hardware yang diperlukan untuk membuat
kerangka global yang menggambarkan mekanisme dari sistem
yang akan dibuat.

Implementasi dan Pengujian Sistem

Berisi tentang implementasi dari perancangan sistem yang telah
dibuat serta pengujian terhadap sistem tersebut.

: Penutup

Merupakan bab terakhir yang memuat intisari dari hasil
pembahasan yang berisikan kesimpulan dan saran yang dapat
digunakan sebagai pertimbangan untuk pengembangan penulisan
selanjutnya.



BAB II
LANDASAN TEORI

2.1 Pembelajaran“]

Menurut Ouda Teda Ena (2001), pembelajaran adalah sebuah proses
komunikasi antara pembelajar, pengajar, dan bahan ajar. Komunikasi tidak akan
berjalan tanpa bantuan sarana penyampai pesan atau media. Sedangkan menurut
Max Darsono dkk (1992) pengertian pembelajaran dapat dibagi menjadi dua yaitu
secara umum dan secara khusus.

1. Umum
Belajar merupakan suatu kegiatan yang mengakibatkan terjadinya
perubahan tingkah laku, sehingga pengertian pembelajaran adalah suatu
kegiatan yang dilakukan oleh guru sedemikin rupa, sehingga tingkah laku siswa
berubah ke arah yang lebih baik.
2. Khusus
a. Behavioristik
Pembelajaran adalah suatu usaha membentuk tingkah laku yang
diinginkan dengan menyediakan lingkungan (stimulus). Agar terjadi hubungan
stimulus dan respon (tingkah laku yang diinginkan) perlu latihan, dan setiap
latihan yang berhasil harus diberi hadiah atau reinforcement (penguatan).
b. Kognitif
Pembelajaran adalah cara guru memberikan kesempatan kepada siswa
untuk berpikir agar dapat mengenal dan memahami apa yang sedang dipelajari.
c. Gestalt
Pembelajaran adalah usaha guru untuk memeberikan materi pembelajaran
sedemikian rupa, sehingga siswa lebih mudah mengorganisirnya (mengaturnya)
menjadi suatu gestalt (pola bermakna).
d. Humanistik

Pembelajaran adalah memberikan kebebasan kepada siswa untuk memilih

bahan pelajaran dan cara mempelajarinya dengan minat dan kemampuannya.

Kebebasan yang dimaksud tidak keluar dari kerangka belajar.



Dalam pembelajaran tentu ada suatu cara atau teknik tertentu, baik itu
penyampaian maupun media yang digunakan. Salah satu metode yang banyak
berkembang adalah pembelajaran melalui media visualisasi dalam bentuk

penyajian materi yang dilengkapi dengan gambar-gambar dan suara.

2.2 Aksara Jawa!'!

Aksara Jawa, merupakan salah satu peninggalan budaya yang tak ternilai
harganya. Bentuk aksara dan seni pembuatannya-pun menjadi suatu peninggalan
yang patut untuk dilestarikan. Tak hanya di Jawa, aksara Jawa ini juga digunakan
di daerah Sunda dan Bali, meskipun ada sedikit perbedaan dalam penulisannya.
Namun sebenarnya aksara yang digunakan pada dasarnya sama. Sejarah aksara
Jawa ini berasal dari cerita Aji Saka dan Dewata Cengkar. Aksara Jawa terdiri
dari aksara legena atau aksara carakan yaitu aksara Jawa pokok yang jumlahnya
20 buah. Aksara jawa memiliki sifat kesukukataan, hal ini dapat dilihat dari
struktur dari masing-masing huruf yang paling tidak mewakili dua buah huruf
(aksara) dalah huruf latin. Di dalam aksara jawa terdapat aksara carakan (urip),
pasangan (mati), sandhangan, aksara swara, aksara rekan, angka atau wilangan.
Berikut ini adalah penjelasannya:

2.2.1 Cerita Ajisakal”

Pada zaman dahulu di pulau Majethi hidup seorang satria tampan,
berilmu tinggi, dan sakti mandraguna yang bernama Ajisaka. Dia mempunyai
dua orang punggawa yang bernama Dora dan Sembada. Kedua punggawa
tersebut sangat setia dan sama sekali tidak pernah mengabaikan perintahnya.
Pada suatu hari, Ajisaka berkeinginan pergi berkelana. Kepergiannya ditemani
oleh punggawanya yang bernama Dora, sedangkan Sembada tetap tinggal di
pulau Majethi. Sembada diberi perintah oleh Ajisaka untuk menjaga pusaka
andalannya yang berupa keris dan tidak memberikan pusaka tersebut kepada
siapapun kecuali padanya. Dalam perjalanannya, tibalah dia di suatu negara
yang bemama Medhangkamulan. Medhangkamulan. Namun Ajisaka
merasakan keanchan keadaan negara tersebut pada saat kedatangannya.
Negara yang terkenal makmur, aman, dan damai mengapa menjadi sunyi, sepi,
dan mencekam. Ajisaka pun langsung mencari informasi mengenai keadaan



tersebut. Akhirnya Ajisaka mendapatkan jawaban dari keadaan tersebut, yaitu
keadaan sunyi, sepi, dan mencekam tersebut dikarenakan Raja dari
Medhangkamulan yang bernama bernama Prabu Dewatacengkar menjadi
bengis. Raja yang dulunya luhur budinya dan bijaksana kini telah menjadi
seorang pemakan manusia. Hal ini terjadi karena ketidaksengajaanya
memakan jari dari juru masaknya yang terpotong saat memasak dan masuk ke
makanannya. Dia merasakan ada daging yang enak telah termakannya. Setelah
dia diberitahu oleh juru masak tersebut bahwa yang dimakan tersebut adalah
Jjarinya yang tidak sengaja terpotong maka Dia pun langsung meminta daging
manusia untuk santapan setiap harinya. Hal inilah yang membuat keadaan
menjadi seperti itu. Melihat keadaan tersebut Ajisakapun tidak mau tinggal
diam. Ajisaka langsung menuju kerajaan dan merelakan dirinya untuk
dijadikan santapan sang Raja. Melihat hal itu, Rajapun dengan senang hati
menerimanya. Namun sebelum Ajisaka dijadikan santapan, dia mempunyai
satu permintaan, yaitu sejengkal tanah yang panjangnya sama dengan kain
yang dipakai di kepalanya. Sang raja pun mengabulkan permintaannya.
Ajisaka melepas ikat kepala tersebut dan Prabu Dewatacengkar pun langsung
mengukurnya sendiri. Saat Prabu Dewatacengkar menarik kain tersebut
dengan berjalan mundur dia tidak tahu bahwa dia menariknya menuju laut
lepas. Setelah tahu Prabu Dewatacengkar mendekati laut lepas, Ajisaka pun
langsung mengkibaskan kain tersebut yang akhirnya membuat Prabu
Dewatacengkar terpental ke laut lepas dan mati. Setelah kejadian itu, Ajisaka
langsung diangkat menjadi raja di Medhangkamulan. Suatu hari, Ajisaka
menyuruh punggawanya yaitu Dora untuk mengambil pusaka andalannya
yang ditinggal di Pulau Majethi. Ajisaka juga memberi peringatan kepada
Dora agar dia tidak kembali ke Medhangkamulan sebelum mendapatkan
pusaka tersebut. Tanpa banyak bicara, Dora pun langsung melaksanakan
perintah Ajisaka. Namun sesampainya di pulau Majethi, Dora tidak dapat
mengambil pusaka tersebut karena Sembada (punggawa yang diberi tugas oleh
Ajisaka untuk menjaga pusakanya) tidak mengizinkan Dora untuk
mengambilnya. Akhirnya terjadilah perselisihan diantara kedua punggawa
tersebut. Mereka berdua saling beradu kesaktian dan keduanya pun tewas



dalam peperangan tersebut. Dikemudian hari Ajisaka bertanya-tanya dan
merasa curiga kepada Dora karena salah satu punggawanya tersebut tidak
kembali. Melihat hal itu, dia pun langsung mengutus patihnya untuk melihat
keadaan di Pulau Majethi. Sang patih segera melaksanakan perintah Ajisaka.
Namun, saat kembali patih membawa berita yang buruk, yaitu kedua
punggawa Ajisaka tersebut telah tewas. Mendengar berita tersebut, Ajisaka
pun akhirnya menyadari bahwa tewasnya kedua punggawanya tersebut pasti
karena perintahnya tersebut. Ajisaka juga sangat menyesalkan kejadian
tersebut mengingat kesetiaan kedua punggawa kesayangannya itu kepadanya.
Kesedihannya telah mendorongnya untuk menciptakan aksara guna
mengabadikan kedua orang yang dikasihinya itu, yang bunyinya adalah
sebagai berikut:
Ha Na Ca Ra Ka
Ana utusan ( ada utusan )
Da Ta Sa Wa La
Pada kekerengan (saling berselisih pendapat)
Pa Dha Ja Ya Nya
Padha digdhayane (sama-sama sakti)
Ma Ga Ba Tha Nga
Padha dadi bathange (sama-sama menjadi mayat)

2.2.2 Huruf Dasar (Aksara Carakan / Nglegena)

Aksara Carakan / Legena yaitu aksara Jawa pokok yang jumlahnya 20
buah. Bentuk kedua puluh aksara Jawa dapat dilihat pada tabel 2.1.

Tabel 2.1 Tabel Aksara Carakan / Legena

st : Aksara nglegena 7
m ®M N MnmoomW oM oM mm
Ha | Na. .Ca Ra 7 Ka Da Ta . Sa Wa 7 La
m W K M om @ m o 11 A
Pa Dha Ja Ya Nya Ma Ga Ba Tha Nga

Contoh : Ramayana = T] mmm nﬂ



2.2.3 Pasangan

Pasangan berfungsi untuk menghubungkan suku kata konsonan dengan
suku kata berikutnya. Penulisan Pasangan ada yang dituliskan di atas sejajar
dengan aksara carakan dan ada yang dituliskan di bawah. Bentuk dari aksara

pasangan dapat dilihat pada tabel 2.2.

Tabel 2.2 Tabel Pasangan
Aksara pasangan
v} ] n B & w C el n
Ha Na Ca | Ra Ka Da Ta Sa Wa La
| | 1 v
w Ic)] m d C m a b n
Pa Dha Ja Ya Nya Ma Ga Ba Tha | Nga

Contoh : Panca = Mnﬂ

2.2.4 Aksara Swara
Aksara Swara dalam penulisan Hanacaraka digunakan untuk
menuliskan aksara vokal yang menjadi suku kata, terutama yang berasal dari
bahasa asing dan mempertegas pelafalannya. Bentuk dari aksara swara dapat
dilihat pada tabel 2.3.
Tabel 2.3 Tabel Aksara Swara

Aksara Swara

6A 2 i g 1

Contoh : Ali = G‘:ﬂ.ﬂl?l

2.2.5 Aksara Rekan

Aksara Rekan digunakan untuk menuliskan aksara konsonan pada kata -
kata asing yang masih dipertahankan seperti aslinya. Bentuk dari aksara rekan
dapat dilihat pada tabel 2.4.



Tabel 2.4 Tabel Aksara Rekan

R R
il LU ' I 1 w

Gha Fa/va Kha Dza Za

= O
Contoh : Dzalim = MI ﬂmmll

2.2.6 Sandhangan
Sandhangan adalah tanda yang dipakai sebagai pengubah bunyi di
dalam tulisan Jawa. Bentuk dari sandhangan dapat dilihat pada tabel 2.5.
Tabel 2.5 Tabel Sandhangan

Nama Sandhangan Aksara Jawa  Keterangan

Whulu o ‘tanda vokal i

'Suku U tandavokal u |

| 1 \

ITaling | ”] ‘tanda vokal é |

EPepet o tanda vokal e

{Taling Tarung . "] 2 tanda vokal o

Layar / tanda ganti konsonanr |

‘Wignyan - % ‘tanda ganti konsonan h |
‘ ‘

\Cecak ‘ . ‘tanda ganti konsonan ng

'Pangkon II ‘tanda penghilang vokal

£
Contoh : Jakarta = ﬂKﬂﬂ] ﬂSﬂ
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2.2.7 Angka Jawa
Angka dalam aksara Jawa dipakai untuk menyatakan lambang bilangan
atau nomor. Bentuk dari angka Jawa dapat dilihat pada tabel 2.6.
Tabel 2.6 Tabel Angka Jawa
Angka Jawa

moy W e a 4 m m om0

Contoh: 1945 = TN G G)

2.2.8 Tanda Baca
Dalam Hanacaraka terdapat pula tanda-tanda baca yang digunakan
dalam penulisan kalimat, paragraf dan lainnya. Bentuk dari tanda baca aksara
Jawa dapat dilihat pada tabel 2.7.
Tabel 2.7 Tabel Tanda Baca Jawa

Tanda Baca Aksara Jawa Keterangan
Adeg - Adeg “ Tanda awal kalimat
. W o
Pada Lungsi Tanda titik
Pada Lingsa : Tanda koma
Pada Pangkat B Penanda angka
¥

o O £2 £2
Contoh : Ani belajar sepeda. = ]1 G:ﬂﬂ'ﬁl ﬂ:ﬂ mﬂﬂK @ﬂ ﬂ.ﬂ ﬂJ] flf"ss
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2.3 Multimedia

Multimedia adalah gabungan dari beberapa unsur yaitu teks, grafik, suara,
video dan animasi yang menghasilkan presentasi yang menakjubkan. Multimedia
juga mempunyai komunikasi interaktif yang tinggi. Sedangkan definisi
multimedia adalah pemanfaatan komputer untuk membuat dan menggabungkan
teks, grafik, animasi, audio, gambar bergerak ( video dan animasi ) yang
memungkinkan pemakai melakukan navigasi, berinteraksi, berkreasi, dan
berkomunikasi. Dalam defenisi ini terkandung empat komponen penting
multimedia. Pertama, harus ada komputer yang mengkoordinasikan apa yang
dilihat dan yang didengar. Kedua, harus ada hubungan yang memungkinkan
pemakai dengan informasi. Ketiga, harus ada alat navigasi yang membantu
pemakai menjelajah jaringan informasi yang saling terhubung. Keempat,
multimedia juga menyediakan tempat kepada pemakai untuk mengumpulkan,

memproses dan mengkomunikasikan informasi dengan baik.
Unsur - Unsur Multimedia

1. Teks adalah bentuk data multimedia yang paling mudah disimpan dan
dikendalikan. Teks merupakan yang paling dekat dengan kita dan yang paling
banyak kita lihat. Teks dapat membentuk kata, surat atau narasi dalam
multimedia yang menyajikan bahasa kita. Kebutuhan teks tergantung pada
kegunaan aplikasi multimedia. Secara umum ada empat macam teks yaitu teks
cetak, teks hasil scan, teks elektronis dan hyperteks. Teks dapat disajikan
dalam berbagai bentuk (font) dan ukuran,

2. Animasi adalah merupakan penggunaan komputer untuk menciptakan gerak
pada layar. Ada sembilan macam animasi yaitu animasi se/, animasi frame,
animasi sprite, animasi lintasan, animasi spline, animasi vector, animasi
karakter, animasi computational dan morphing. Animasi akan sangat menarik
apabila bisa menghilangkan kejenuhan yang menonton.

3. Gambar. Alasan untuk menggunakan gambar dalam presentasi atau publikasi
multimedia adalah karena lebih menarik perhatian dan dapat mengurangi
kebosanan dibandingkan dengan teks. Gambar dapat meringkas dan
menyajikan data kompleks dengan cara yang baru dan lebih berguna. Sering
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dikatakan bahwa sebuah gambar mampu menyajikan seribu kata. Tapi ini
berlaku hanya ketika kita biasa menampilkan gambar yang diinginkan saat
kita memerlukannya. Multimedia membatu kita melakukan hal ini, yakni
ketika gambar grafis menjadi objek suatu link. Grafis sering kali muncul
sebagai backdrop (latar belakang) suatu teks untuk menghadirkan kerangka
yang mempermanis teks. Secara umum ada lima macam gambar atau grafik
yaitu gambar vektor (vector image), gambar bitmap (bitmap image), clip
art, digitized picture dan hyperpicture.

. Suara / Audio adalah sebuah bunyi dalam bentuk digital seperti suara, musik,
narasi, dan sebagainya. Dengan suara, pendengar dapat mendengar bunyi
suatu kata atau informasi dengan tepat. Komputer multimedia tanpa bunyi
hanya disebut unimedia, bukan multimedia. Bunyi atau sound dapat kita
tambahkan dalam produksi multimedia melalui suara, musik dan efek-efek
suara. Seperti halnya pada grafik, kita dapat membeli koleksi sound disamping
Jjuga menciptakan sendiri. Beberapa jenis objek bunyi yang biasa digunakan
dalam produksi multimedia yakni format waveform audio, compact disk
audio, MIDI sound track dan mp3.

. Video adalah rekaman gambar hidup atau gambar bergerak yang saling
berurutan. Terdapat dua macam video yaitu video analog dan video digital.
Video analog dibentuk dari deretan sinyal elektrik (gelombang analog) yang
dirckam oleh kamera dan dipancarluaskan melalui gelombang udara.
Sedangkan video digital dibentuk dari sederetan sinyal digital yang berbentuk
yang menggambarkan titik sebagai rangkaian nilai minimum atau maksimum.
Terdapat tiga komponen utama yang membentuk video digital yaitu frame
rate, frame size dandata type. Frame rate menggambarkan berapa Kkali
bingkai gambar muncul setiap detiknya, sementara frame size merupakan
ukuran fisik sebenarnya dari setiap bingkai gambar dan data type menentukan
seberapa banyak perbedaan warna yang dapat muncul pada saat bersamaan.



13

2.4 Flowchart

Flowchart adalah representasi grafik dari langkah-langkah yang harus
diikuti dalam menyelesaikan suatu permasalahan yang terdiri atas sekumpulan
simbol, dimana masing-masing simbol merepresentasikan suatu kegiatan tertentu.
Flowchart diawali dengan penerimaan input, kemudian pemrosesan input, dan
diakhiri dengan penampilan output. Bentuk dari simbol - simbol flowchart dapat

dilihat pada tabel 2.8.
Tabel 2.8 Tabel Simbol - Simbol Flowchart
SIMBOL NAMA FUNGSI
@ TERMINATOR Permulaan / akhir program
GARIS ALIR
—_— Arah aliran program
(FLOW LINE) progr
Proses inisialisasi / pemberian
C> PREPARATION
harga awal
Proses perhitungan / proses
PROSES pe s P
pengolahan data
INPUT/OUTPUT Proses input / output data,
E DATA parameter, informasi
PREDEFINED
Permulaan sub program / proses
PROCESS . N
(SUB PROG menjalankan sub program
Perbandingan pernyataan,
nyeleksian data yan
DECISION peny yane
memberikan pilihan untuk langkah
selanjutnya
Penghubung bagian-bagian
ON PAGE eh & bagt &
O Sflowchart yang berada pada satu
CONNECTOR
halaman
Penghubung bagian-bagian
OFF PAGE gl; ; s tg)le ada &
G co TOR Sflowchart yang berada pada
halaman berbeda
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2.5 Adobe Photoshop"’

“Adobe Photoshop 70

Gambar 2.1 Gambar Adobe Photoshop
Gambar 2.1 adalah tampilan saat kita membuka aplikasi Adobe

Photoshop. Adobe Photoshop adalah sebuah program yang digunakan untuk

melakukan perubahan - perubahan (manipulasi) pada gambar, yang dapat

menghasilkan gambar digital dengan kualitas tinggi. Adobe Photoshop juga dapat
melakukan perubahan - perubahan dari gambar atau foto hasil scanner. Misalnya
dengan memperbesar atau memperkecil gambar yang sudah ada, melakukan rotasi

(perputaran), merubah warna, memberi efek-efek khusus seperti yang terdapat

pada menu filter. Photoshop memiliki kemampuan untuk membaca dan menulis

gambar berformat raster dan vektor seperti .png, .gif, .jpeg, dan lain-lain.

Photoshop juga memiliki beberapa format file khas:

A. .PSD (Photoshop Document) adalah format yang menyimpan gambar dalam
bentuk /ayer, termasuk teks, mask, opacity, blend mode, channel warna,
channel alpha, clipping paths, dan setting duotone. Kepopuleran photoshop
membuat format file ini digunakan secara luas, sehingga memaksa programer
menambahkan suatu sofiware untuk membaca format PSD dalam perangkat
lunak mereka.

B. .PSB adalah versi terbaru dari PSD yang didesain untuk file yang berukuran
lebih dari 2 GB
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C. .PDD adalah versi lain dari PSD yang hanya dapat mendukung fitur perangkat
lunak Photo Deluxe.

Awalnya Photoshop dirancang untuk menyunting gambar untuk cetakan
berbasis kertas. Photoshop yang ada saat ini juga dapat digunakan untuk
memproduksi gambar untuk World Wide Web. Beberapa versi terakhir juga
menyertakan aplikasi tambahan, yaitu Adobe Image Ready, untuk keperluan
tersebut. File format asli Photoshop (.PSD) juga dapat diekspor ke dan dari Adobe
ImageReady.

2.5.1 Area Kerja Adobe Photoshop
Area kerja dari Adobe Photoshop adalah seperti pada gambar 2.2.
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Gambar 2.2 Gambar Area Kerja Adobe Photoshop

A. Toolbox
Toolbox berisi berbagai macam fools yang digunakan untuk

melakukan manipulasi image.
B. Tool Option Bar
Hampir semua ‘ools pada Toolbox memiliki options, yang
ditampilkan pada Tool Option Bar. Options tersebut digunakan
untuk mengatur nilai parameter dari ool yang sedang aktif / dipilih.
C. View area untuk image
Bagian ini digunakan untuk menampilkan image yang sedang
dikerjakan.
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D. Menu Bar
Berikut adalah menu - menu yang terdapat pada Adobe Photoshop:

a,

File

Berkaitan dengan file seperti menyimpan, membuka, export,
import, dan cetak.

Edit

Berkaitan dengan editing secara umum seperti cw, copy,
paste, transform image, serta untuk mengatur preferences
Adobe Photoshop.

Image

Berisi editing image untuk mengatur warna, hue / saturation,
brightness / contrast, dan ukuran.

Layer

Berkaitan dengan manajemen lJayer pada image, seperti
menambah /ayer, menghapus, menambah efek pada /ayer, serta
masking.

Select

Berkaitan dengan selection image.

Filter

Berisikan filter - filter yang terinstall pada Photoshop yang
dapat digunakan untuk memberi efek tertentu pada image.

View

Digunakan untuk pengaturan view seperti zooming image,
menampilkan skala, dan sebagainya.

Window

Digunakan untuk pengaturan window.

Help

Digunakan untuk menampilkan help Adobe Photoshop.

E. Status Bar
Status bar berisikan keterangan mengenai toolbox yang sedang aktif,
serta keterangan image yang sedang aktif. Tekan A4lt + click pada

status bar untuk mengetahui size dan jenis warna image.
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F. Palette (dari atas ke bawah: navigation palette, color palette,
history palette, dan layer palette).
Palette Photoshop yang berguna untuk memudahkan dalam
navigasi maupun editing image.

G. Palette Well (hanya tampak apabila resolusi layar di atas 800 x
600)
Palette Well digunakan untuk memudahkan dalam pengaturan
palette. Namun palette well hanya tersedia jika resolusi layar lebih
besar dari 800 x 600 (resolusi minimal yang disarankan adalah
1024 x 768). Apabila suatu palette diletakkan di palette well, maka
palette akan bersifat tersembunyi. Ketika title dari palette diklik,
barulah palette akan ditampilkan. Jika area di luar palette di klik,

maka palette tersebut akan tersembunyi kembali.

2.6 Macromedia Flash®!

/ II-'_”i:KéH'Professional 8 |

Copyright (¢) 1993-2005 Macremedia, Inc. and its licensors

FAill rights reserued. Macromedia, the Macromedia logo, Flash,

and Macromedia Flash are frademarks or registered

trademarks of Macromedia, Inc. in the United Stotes ond/or Copying First Run Files...
other countries. Other marks are the properties of their

respective owners Version 80

Gambar 2.3 Gambar Macromedia Flash

Gambar 2.3 adalah tampilan saat kita membuka aplikasi Macromedia
Flash. Macromedia Flash merupakan program grafis animasi web yang diproduksi
oleh Macromedia Corp, yaitu sebuah vendor software yang bergerak di bidang
animasi web. Macromedia Flash pertama kali diproduksi pada tahun 1996. Pada
awal produksinya, Macromedia Flash merupakan sofiware untuk membuat
animasi sederhana berbasis GIF. Macromedia Flash telah diproduksi dalam
beberapa versi, yaitu Macromedia Flash 5, Macromedia Flash MX 2004 atau

Macromedia Flash versi 7 dan Macromedia Flash versi 8 yang lahir pada tahun
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2005 dan memiliki beberapa fitur - fitur baru. Berkas yang dihasilkan oleh
Macromedia Flash adalah file yang berekstensi .swf dan dapat diputar di
penjelajah web yang telah dipasang Adobe Flash Player.

Macromedia Flash juga didesain dengan kemampuan untuk membuat
animasi 2 dimensi yang handal dan ringan sehingga Macromedia Flash banyak
digunakan untuk membangun membuat efek animasi pada website. Macromedia
Flash juga dapat digunakan untuk membuat animasi logo, movie, game,
pembuatan navigasi pada suatu website, tombol animasi, banner, menu interaktif,
formulir interaktif, e-card, screensaver, dan pembuatan aplikasi web lainnya.
Keunggulan lain yang dimiliki Macromedia Flash adalah ia mampu diberikan
sedikit kode pemrograman, baik yang berjalan sendiri untuk mengatur animasi
yang ada didalamnya atau digunakan untuk berkomunikasi dengan program lain
seperti HTML, PHP, Database dengan pendekatan XML yang dapat
dikolaborasikan dengan web, dan kecil dalam ukuran file outputnya. Bahasa yang
digunakan Macromedia Flash adalah bahasa pemrograman yang bernama Action
Script yang muncul pertama kalinya pada Flash 5. Area kerja dari Macromedia
Flash adalah seperti pada gambar 2.4.
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Gambar 2.4 Gambar Area Kerja Macromedia Flash
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Menu Bar

Menu Bar merupakan barisan menu yang berisi kumpulan perintah yang
digunakan pada Macromedia Flash. Menu Bar terdiri dari beberapa menu
yaitu menu File, Edit, View, Insert, Modify, Text, Control, Window, Help.
Toolbar

Toolbar merupakan baris menu yang ditandai dengan berbagai icon. Toolbar
merupakan jalan pintas untuk menjalankan menu.

Toolbox

Bagian dari Macromedia Flash yang terdiri dari bermacam tool yang berfungsi
untuk membuat gambar, memilih objek, dan memanipulasi pewarnaan objek

yang merupakan komponen dari stage.

. Stage

Area yang digunakan untuk membuat animasi atau meletakkan objek. Stage
juga dapat diibaratkan seperti sebuah kanvas untuk mengkomposisi frame -
Jframe sehingga membentuk sebuah movie.

Timeline

Timeline berisi frame - frame yang berfungsi untuk mengontrol objek yang
dibuat dalam stage atau layer yang akan dibuat animasinya seperti kapan
sebuah objek muncul dan kapan sebuah objek hilang.

Panel

Jendela yang berfungsi mengontrol atau memodifikasi berbagai atribut dari
objek atau animasi, seperti pewarnaan lebih detail terhadap objek atau
pemberian aksi atau kerja terhadap suatu objek pada stage.

Istilah - istilah dalam Macromedia Flash

Artwork : bagian dari animasi yang dapat berupa objek gambar vektor,
gambar bitmap, teks, video, atau objek lain.

Layer : Lapisan - lapisan yang memuat artwork.

c. Frame : Bagian dari animasi yang menunjukkan setiap perubahan yang terjadi

Animasi : Proses bergeraknya objek atau beberapa objek dari suatu posisi ke
posisi lain.
Movie : Hasil dari serangkaian animasi.
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2.6.1 Action Script'®
Action Script adalah bahasa pemograman yang digunakan di dalam
program flash yang berfungsi untuk memberikan perintah pada animasi flash.
Hingga saat ini sudah terdapat 3 versi, yaitu:
1. Actionscript 1.0 (tahun 2000 - tahun 2003) mulai dipergunakan pada Flash
5 dengan minimal dimainkan di Flash Player 5.
2. Actionscript 2.0 (tahun 2003 - tahun 2006) mulai dipergunakan pada Flash
MX 2004 dengan minimal dimainkan di Flash Player 7.
3. Actionscript 3.0 (tahun 2006 sampai sekarang) mulai dipergunakan pada
Flash CS3 dengan minimal dimainkan di Flash Player 9.
Di Flash, actionscript ditulis pada panel actions. Untuk melihat suatu frame
telah diberi script atau tidak, kita dapat melihat tanda berupa hurup 'a' kecil
pada frame ( ). Penulisan actionscript di panel actions dapat dilakukan pada
3 tempat yaitu pada movie clip, button, dan frame. Ketiga buah tempat tadi
memiliki aturan penulisan yang berbeda.
1. Untuk menjalankan event pada button, script pada button aturan
penulisannya adalah:

on(event)

{

perintah ;

}
2. Untuk menjalankan event pada movie clip, script pada movie aturan

penulisannya adalah:

on(event)

{

perintah ;

/

atau

onClipEvent ()
{

perintah ;

}
3.Untuk menjalankan event pada frame, script pada frame aturan

penulisannya adalah:
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onLoad=function ()

{

perintah ;

/

atau

onEnterFrame=function()

:

perintah ;

/

atau

onRelease=function()

{

perintah ;

}

dan lain sebagainya.

Beberapa contoh actionscript yang sering digunakan dapat dilihat di tabel 2.9.

Tabel 2.9 Tabel Beberapa Contoh Action Script

Perintah Keterangan
- Penjumlahan
- Pengurangan
= Sama dengan
Stop() Menghentikan animasi
Play() Menjalankan animasi
On(release) Event pada saat button ditekan
2.7 Adobe Audition"*!

R

Gambar 2.5 Gambar Adobe Audition

AdObe-AU,dition‘“ Y
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Gambar 2.3 adalah tampilan saat kita membuka aplikasi Adobe Audition.
Adobe Audition merupakan suatu program yang digunakan untuk merekam,
mengedit suara dalam bentuk digital yang berbasis Windows. Program ini
dilengkapi dengan modul - modul efek suara, seperti Delay, Echo, Pereduksi
Noise / Hiss, Reverb, Pengatur Tempo, Pitch, Graphic dan Parametric Equalizer.
Adobe Audition memberikan fasilitas perekaman suara sampai dengan 128
track hanya dengan satu sound card, hal ini akan memberikan kemudahan bagi
seorang sound editor untuk berekspresi lebih jauh. Edit suara bisa dilakukan
dalam bentuk .wav dan penyimpanan bisa dirubah dalam bentuk format seperti
.wma, .mp3, mp3pro, dll. Dalam proses perekaman, pada umumnya melalui
beberapa tahap :
1. Take Voice
Tahapan ini berupa pengambilan suara-suara yang diperlukan sesuai dengan
kebutuhan script. Pengambilan suara bisa dilakukan diluar (outdoor) studio
atau di dalam studio (indoor). Untuk outdoor, take voice dilakukan dengan
sebuah alat perekam seperti fape recorder atau sejenisnya. Sedangkan untuk
indoor dilakukan didalam studio misalnya ftake voice oleh presenter.
Kelebihan dari take voice indoor akan dihasilkan kualitas suara yang lebih
bagus kaena bebas dari suara - suara yang luar yang tidak perlu.
2. Loading + Editing
Tahap ini memasukan suara hasil fake voice kedalam perangkat editing. Dari
perangkat ini suara akan diedit sesuai dengan kebutuhan, seperti
menghilangkan noise, atau mengequalize suara sebelum di campur (mixing)
dengan suara-suara lain.
3. Mixing
Tahap pencampuran suara-suara sesuai dengan suara yang dibutuhkan
berdasarkan kebutuhan script. Mengatur suara latar (back sound misalnya
music, effect, smash dan lain sebagainya), level volume suara dilakukan di
tahap ini.
4. Transfering
Memindahkan suara hasil mixing ke media penyimpanan seperti kaset,
harddisk, dan lain sebagainya.
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Area kerja dari Adobe Audition adalah seperti pada gambar 2.6.

Menu Bar Panel

“Waek| G00c00 [ pIocs I oo |

Gambar 2.6 Gambar Area Kerja Adobe Audition

A. Menu Bar
Menu Bar merupakan barisan menu yang berisi kumpulan perintah yang
digunakan pada Adobe Audition. Menu Bar terdiri dari beberapa menu yaitu
menu File, Edit, View, Effect, Generate, Analize, Favorites, Option, Window,
Help.
B. Panel
Panel dari area kerja Adobe Audition didedakan menjadi beberapa, yaitu:
a. Panel Files dan Effects
Panel ini digunakan untuk mengimport file - file audio dengan berbagai
macam format yang siap untuk diedit dengan effect yang telah disediakan.
b. Panel Main
Panel ini berisi tentang grafik hasil dari proses perekaman audio yang telah
dilakukan ataupun file audio yang dipilih dan akan diedit.
c. Panel Transport
Panel ini berisi tombol Stop, Play, Pause, Play from cursor to end of view,

Play Looped, Previous, Rewind, Forward, Next, dan Record yang nantinya
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banyak digunakan dalam proses editing audio.

d. Panel Time
Panel ini berisi tentang waktu yang dimiliki oleh fi/e audio yang akan kita
edit ataupun lamanya kita dalam proses perekaman audio.

e. Panel Zoom
Panel ini digunakan untuk memperbesar atau memperkecil grafik dari
audio yang ada di panel main.

f. Panel Selection/View
Panel ini berisi tentang waktu awal dan akhir dari proses, beserta panjang
waktu dari hasil selection audio yang kita lakukan.

g. Panel Levels

Panel ini berisi tentang tingginya volume yang dimiliki oleh file audio.

2.8 Borland Delphi®

m“and'

©2002 Borland Software Corporation

Gambar 2.7 Gambar Borland Delphi
Gambar 2.7 adalah tampilan saat kita membuka aplikasi Borland Delphi.
Borland Delphi adalah kompiler atau penerjemah bahasa Delphi (awalnya dari
Pascal) yang merupakan bahasa tingkat tinggi sekelas dengan Basic atau C yang
merupakan produk dari Borland Corp. Bahasa Pemrograman di Delphi disebut
bahasa procedural artinya bahasa atau sintaknya mengikuti urutan atau prosedur

tertentu.
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Borland Delphi termasuk keluarga Visual sekelas Visual Basic atau Visual
C. Perintah - perintah di Borland Delphi untuk membuat objek dapat dilakukan
secara visual. Pemrogram tinggal memilih objek apa yang ingin dimasukkan
kedalam Form atau Window, kemudian untuk memberikan tindakan objek
tersebut saat menerima evens atau aksi tinggal dibuat programnya. Delphi
merupakan bahasa berorentasi objek, artinya nama objek, properti dan method

atau procedure dikemas menjadi satu kemasan (encapsulate).

Delphi merupakan bahasa pemograman berbasis objek, artinya semua
komponen yang ada di Delphi merupakan objek. Ciri sebuah objek adalah
memiliki nama, properti dan method atau procedure. Delphi disebut juga visual
programming artinya komponen-komponen yang ada tidak hanya berupa teks
tetapi muncul berupa gambar - gambar. Area kerja dari Borland Delphi adalah
seperti pada gambar 2.8.
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Gambar 2.8 Gambar Area Kerja Borland Delphi
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A. Menu Bar
Barisan menu yang berisi kumpulan perintah yang digunakan pada Delphi.
Menu Bar terdiri dari beberapa menu yaitu menu File, Edit, Search, View,
Project, Run, Component, Database, Tools, Window, Help.

B. Toolbar
Toolbar merupakan baris menu yang ditandai dengan berbagai icon. Toolbar
merupakan jalan pintas untuk menjalankan menu.

C. Component Pallete
Kumpulan icon yang digunakan untuk merancang dan membentuk suatu
aplikasi user interface.

D. Object Treeview
Diagram pohon yang menggambarkan hubungan semua komponen yang
terdapat dalam suatu proyek program atau menampilkan seluruh dafiar
komponen dari program dalam sebuah aplikasi.

E. Object Inspector
Jendela yang digunakan untuk mengatur tampilan komponen, seperti
mengubah nama komponen atau penempatan komponen dan memberikan
fungsi pada komponen.

F. Form Designer
Tempat yang digunakan untuk merancang semua aplikasi program yang
diambil dari komponen pallete.

G. Code Editor
Bagian Delphi yang digunakan untuk menuliskan kode program.

Komponen - Komponen Borland Delphi
Komponen Delphi terletak pada Component Pallete yang berbentuk icon -
icon dan dikelompokkan sesuai dengan fungsi dan kegunaannya. Contoh beberapa
komponen Borland Delphi dapat dilihat pada tabel 2.10.
Tabel 2.10 Tabel Beberapa Komponen Borland Delphi

No Icon Nama Fungsi

I—E Mengembalikan fungsi mouse ke

1 Pointer
defaultnya
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2 5 Main Menu Membuat Menu
3 A Label Membuat 7ext
4 3 Edit Membuat kotak inputan satu baris
a Membuat kotak inputan yang terdiri
5 — Memo ) )
dari beberapa baris
Digunakn untuk melakukan proses
6 o8] Button .
eksekusi
7 ® Radio Button Digunakan unutuk menentukan pilihan
8 Panel Mengelompokkan beberapa komponen
= g P P P
9 = Image Memberikan atau memasukkan gambar
10 b7 Shockwave Flash | Memberikan atau memasukkan animasi
]

Script atau Perintah pada Borland Delphi

Script atau perintah pada Delphi selalu dituliskan pada Code Editor dari

Delphi. Penulisan Script atau perintah pada Delphi dilakukan di bawah prosedur

suatu komponen yang diawali kata “begin” dan diakhiri kata “end” dan diberi

tanda titik koma (;) setelah menulis perintah yang bermacam - macam bentuknya.

Berikut ini adalah beberapa contoh script atau perintah Delphi:

a. Menampilkan Form

Untuk menampilkan form, maka ketikkan perintah:

Procedure
begin

F or}n... Show;

end;




b. Menutup Form
Untuk menutup form, maka ketikkan perintah:

Procedure. .. ..
begin

Application. Terminate;

end}

¢. Merubah Warna
Untuk merubah warna dari suatu komponen, maka ketikkan perintah:

Procedure. . ...
begin

Kor;xponen.F ont.Color:=Warna yang dikehendaki;

end;

d. Memanggil File Animasi

Untuk memanggil file animasi pada komponen Shockwave Flash, maka

ketikkan perintah:

Procedure. . . ..
begin

ShockwaveFlash... .Movie:="Alamat file animasi... /nama
animasi.ekstensi’;

end:

e. Memanggil File Suara
Untuk memanggil file suara, maka ketikkan perintah:

Procedure. . ...
begin

PIa}Sound (PChar (‘Alamat file suara... /nama file '), 0, SND_ASYNC);;

end:'




f. Mencari Panjang Text
Untuk mencari panjang suatu fext, maka ketikkan perintah:

Procedure. . ...
begin

Kor;zponen tempat hasil pencarian . Text: <inttostr(length (komponen yang
dicari panjang textnya.Text));;

end;

g. Mencopy String
Untuk mencopy suatu text, maka ketikkan perintah:

Procedure. . ...
begin

Komponen tempat hasil pencopian .Text:=copy(komponen yang dicopy
textnya, Text, mulai dari index, sebanyak);

end:




BAB I
ANALISA DAN PERANCANGAN SISTEM

Pada bab ini dijelaskan mengenai analisa dan perancangan aplikasi yang

ditunjukan untuk memberikan gambaran secara umum tentang aplikasi dan

memberikan solusi terhadapan permasalahan yang dihadapi.

3.1 Analisa Sistem
Aplikasi yang akan dibuat pada tugas akhir ini adalah sebuah aplikasi yang
dapat membantu seseorang untuk lebih mengenal aksara Jawa dan berlatih

menuliskanya yaitu dengan melihat dan mengikuti cara penulisan aksara Jawa
melalui contoh penulisan yang ada. Menerjemahkan dari aksara Jawa ke huruf
latin ataupun sebaliknya, yaitu huruf latin ke aksara Jawa. Dan mengukur
kemampuan seseorang dalam mengenal dan memahami aksara Jawa melalui soal-
soal latihan atau tes yang telah disediakan.

3.2 Alur Sistem
Pada bagian ini akan dijelaskan mengenai desain alur sistem dari aplikasi.

Gambar 3.1 adalah gambar dari desain alur sistem aplikasi yang akan dibuat.
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Gambar 3.1 Desain Alur Sistem
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Bagan ini merupakan gambaran umum dari aplikasi yang akan dibuat.
Berikut ini adalah penjelasan dari desain alur sistem:
A. Intro
Halaman ini adalah halaman pembuka dari aplikasi.
B. Menu
Halaman ini terbagi menjadi beberapa bagian, yaitu

a.

Sejarah

Menu ini berisi halaman cerita Ajisaka. Cerita Ajisaka adalah cerita
mengenai asal mula dari terciptanya aksara Jawa.

Pembelajaran

Menu ini terbagi menjadi tujuh bagian, yaitu halaman Aksara
Carakan, halaman Pasangan, halaman Sandhangan, halaman Angka
Jawa, halaman Aksara Swara, halaman Aksara Rekan, dan halaman
Tanda Baca. Di dalam setiap halaman tersebut terdapat penjelasan -
penjelasan dan contoh - contoh penulisan aksara Jawa.
Penerjemahan

Menu ini terbagi menjadi dua bagian, yaitu halaman Latin — Aksara
Jawa dan halaman Aksara Jawa — Latin. Dua buah halaman
tersebut digunakan untuk menerjemahkan huruf latin ke aksara
Jawa ataupun sebaliknya, yaitu dari aksara Jawa ke huruf latin.
Latihan

Menu ini terbagi menjadi tujuh bagian, yaitu halaman Aksara
Carakan, halaman Pasangan, halaman Sandhangan, halaman Angka
Jawa, halaman Aksara Swara, halaman Aksara Rekan, dan halaman
Tanda Baca. Di dalam setiap halaman tersebut terdapat soal - soal
latihan mengenai aksara Jawa yang terbagi menjadi tiga tingkatan
yaitu pemula, menengah, dan mahir.

Tes

Menu ini terbagi menjadi tiga bagian, yaitu halaman pemula,
menengah, dan mahir. Di dalam setiap halaman tersebut terdapat
soal - soal tes aksara Jawa yang soalnya sebagian besar diambil
dari menu latihan.



f. Keluar
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Menu ini digunakan jika pengguna aplikasi ingin keluar dari

aplikasi.

Setelah membentuk desain alur sistem, maka dapat dibentuk sebuah
Sflowchart dari aplikasi yang akan dibuat seperti pada gambar 3.2 dan gambar 3.3.
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Gambar 3.2 Flowchart Aplikasi
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Gambear 3.3 Flowchart Aplikasi
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3.3 Perancangan Sistem
Perancangan desain aplikasi adalah langkah awal dari pembuatan aplikasi
ini. Mulai dari menentukan tampilan dan tata letak tombol hingga script dari
setiap menu yang akan dieksekusi.
Dalam perancangan aplikasi ini, ada beberapa tahapan yang perlu
dilakukan, yaitu:
3.3.1 Mendesain Tampilan
Proses pendesainan tampilan aplikasi ini menggunakan soffware Adobe
Photoshop.
3.3.1.1 Desain Tampilan Form Aplikasi
Proses pendesainannya yaitu dengan cara membuka gambar
yang akan dijadikan sebagai tampilan dari form aplikasi di Adobe
Photoshop. Kemudian memberikan warna putih pada bagian
belakangnya dengan menggunakan Paint Bucket Tool (&3, ) seperti pada
gambar 3.4

Fle Edt Image layer Select Fiter Vew Window heb
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Gambar 3.4 Gambar untuk Desain Form Aplikasi
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Kemudian kita simpan dengan tipe file .bmp seperti pada gambar 3.5.

L. ﬂg{a}] @Hanawaka legend4 @axo_gartmz
e T semar I Hanacaraka lagend3 O exp_garengl
My Recent rouleau_vertical_108 Hanacaraka legend2 exp_bagong1
Documents | gI puipen Hanacar aka legend1 emboh
petrukl Hanacaraka4 @dﬁabg
- ‘@pem.k gHanaczrdcaﬂ @bagnng
Desktop M pena [ Hanacaraka2 o+
‘@b copy Hanacarakal g 3
r lingkaran gareng 2 |
il kasas kedl exp_tangangareng R
My Documents. kuas exp_petru3
gﬂu\m&n _egend_4 exp_petruk2 [
; @Hmacaralu_hqmd_s ﬂm _petruk 1 |
Hanacaraka_jegend_2 Hillexp_muutgareng g
My Computer | fHanacaraka_legend_1 [flexp_mulutbagong |

PT L L hduibunlell 179

My Network ; Rogane: %, .f"d"m'“"'ml:’ ) 1 =
| Segpupwass =il
| Eomat: PNGCRNG , (] [Lcamal ]
Save: @ As 2 Copy L Ar
A\ CLavers
Color: Use Prgof Setup: Workng CMY)
Thuming DunLowGseEnensbn
‘A Fiemustblnvndulmpyw&&amcbm
Use Adobe Dislog

Gambar 3.5 Gambar Jendela Save As
Setelah menyimpan gambar tersebut, kita buka aplikasi delphi dan
masukkan komponen Image ( ) yang ada di toolbar pada tab

komponen Additional ke form Delphi seperti pada gambar 3.6.
_
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Gambar 3.6 Gambar Peletakan Komponen /mage pada Form Delphi
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Sesuaikan properties dari komponen image dengan tabel 3.1.

Tabel 3.1 Tabel Properties Komponen /mage

Properti Isi
Name Background
Gambar yang telah di edit sebelumnya
Picture Lo . o
dan akan dijadikan desain form aplikasi
Height 573
Width 673
Top 0
Left 0

dan untuk properties dari form sesuaikan dengan tabel 3.2.

Tabel 3.2 Tabel Properties Form

Properti Isi
Name Form_Aksara Carakan
BorderStyle bsNone
Color clWhite
Position poDesktopCenter
TransparentColor True
TransparentColorValue | cIWhite
Height 566
Width 681

kemudian jalankan aplikasi dengan cara menekan tombol F9 atau
menekan tombol Run (B ) pada toolbar Delphi dan hasil dari desain
Jform yang telah dibuat adalah seperti pada gambar 3.7.



Gambar 3.7 Gambar Desain Form Aplikasi

3.3.2 Pembuatan Animasi
Proses pembuatan animasi pada aplikasi ini menggunakan sofiware

Macromedia Flash 8.

3.3.2.1 Animasi Intro

Untuk memulai membuat animasi

37

kita buka sofiware

Macromedia Flash 8 terlebih dahulu. Kemudian kita masukkan gambar
— gambar yang diperlukan dengan cara klik menu File > Import >

Import to Library seperti pada gambar 3.8.

E!MMMMT&WCMWH&:
New... Ctrl+N

P

1 Open... Crl+0
Open Recent L e T B B B T e e
Close crl+w AR e e B B o SR e PN g
Close Al Ctri-+Alt+W
Save Ctrl4S
Save and Compact
Save As... Ctrl+Shift+5
Save as Template...
Save Al . R
Revert Eﬁl!}ktjrl— 12.0fps | 0.0s @E

ImporttoStage...  Ch4R |

Publsh Settings...  Ctrl+Shift+£12 m&m""""’“ il e
" ,  Import
Publsh Shift+F12 [

Gambar 3.8 Gambar /mport File
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Setelah muncul jendela browse file, pilihlah file yang diperlukan untuk

membuat animasi dan tekan tombol Open seperti pada gambar 3.9.

Look jn: | J) Gambar = O@ e
= @bad‘gmund @mm 4 stanby Iaexp_pelnkz |
= I background huruf I bawah panjang T exp_petruk3
My Recent bawah panjeng kecl @ exp_tangange
Documents | g background menu bawah panjang stanby BB gareng ‘
: background menu utama gmah stanby il gareng
. badkground panel button [ Hanacarakal |
Desktop | HHbackground utama 1 dialog (i Hanacaraka2
M bagong KT drawing-20 copy i Hanacaraka3
: | HHbalon T emboh Hanacarakad |
U i bawsh i exp_bagong1 Hanacaraka le|
My Documents | fmbawah 2 8 exp_garengl i Hanacaraka le|
i bawah 2 stanby i exp_gareng2 il Hanacaraka le!
_ gmm 3 exp_muiutbagong Hanacaraka le,
| bawah 3 stanby exp_mulutgareng Hanacaraka_le
My Computer | fimbawah 4 exp_petrukl titH Hanacaraka_le
4 remmasm— so—— >
mg“ File pame background intro -
Fies of typs | Al Fomats o=

Gambar 3.9 Gambar Jendela Browse File
Buatlah 6 buah /ayer dengan nama Background, Gunungl, Gunung2,
Textl, Text2, dan Text3. Kemudian masukkan semua file yang
dibutuhkan tadi ke dalam area kerja Macromedia Flash. Gambar latar
dimasukkan ke /ayer Background. Gambar gunung dimasukkan ke layer
Gunungl dan Gunung2. Untuk /ayer Textl, Text2, dan Text3 kita isi
dengan judul dari aplikasi seperti pada gambar 3.10.
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Gambar 3.10 Gambar Desain Animasi Intro
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Ubahlah gambar gunung 1 dan gunung 2 menjadi Movie Clip, yaitu
dengan cara klik kanan pada gambar gunung, lalu klik Convert to
Symbol seperti pada gambar 3.11.

i
5
|
~

| Edit with ImageReady

| Swap Bitmap...
j

Timeline Effects »

Gambar 3.11 Gambar Menu Convert to Symbol
Setelah muncul jendela seperti di bawah ini, beri nama symbol tersebut

menjadi gunungl dan gunung? seperti pada gambar 3.12.

Name: }gmungl -

Type: @) Movie dip Registration: 558
S oog
() Graphic

Gambar 3.12 Gambar Jendela Convert to Symbol
Untuk membuat animasi pada gunung adalah dengan cara
menambahkan frame sebanyak 45 buah pada layer gunungl dan
gunung2. Lalu buatlah motion dengan cara mengklik kanan frame
gunungl dan gunung?2 dan klik Create Motion Tween. Kemudian klik
frame 45 pada layer gunungl dan gunung2 dan perbesar ukuran dari
gambar serta letakkan di bagian bawah seperti pada gambar 3.13.
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Gambar 3.13 Gambar Pembuatan Animasi Gunung

Sedangkan untuk membuat animasi fext judul adalah dengan cara

membuat frame di setiap layer Textl, Text2, dan Text3. Text] sebanyak
16 frame dan di mulai dari frame 46, Text2 sebanyak 26 frame dan di
mulai dari frame 63, Text3 sebanyak 20 frame dan di mulai dari frame
89. Setelah itu tekanlah tombol Crr/+B atau klik kanan pada text lalu
dan klik Break Apart agar text terbagi menjadi beberapa karakter.
Bagilah frame layer Textl, Text2, dan Text3 menjadi 2 buah frame
untuk satu karakter. Kemudian hapuslah rext pada layer Textl, Text2,
dan Text3 di setiap frame yang telah dibuat secara berurutan dari
belakang seperti pada gambar 3.14.
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Gambar 3.14 Gambar Pembuatan Animasi 7ext Judul
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Untuk melihat hasil animasinya adalah dengan cara menekan tombol

Ctrl+Enter atau klik menu control dan pilih 7est Movie.

Gambar 3.15 Gambar Hasil Animasi Intro

3.3.2.2 Animasi Cerita Ajisaka

Proses pembuatannya adalah dengan mengimport ke library
Macromedia Flash file - file yang diperlukan untuk membuat animasi
yaitu gambar latar dan gambar wayang, Atur ukuran kertas menjadi 569
x 341 pixel. Drag gambar latar dan gambar wayang ke dalam kertas.
Kemudian buatlah text cerita dengan menggunakan 7ext 700l ( A ) dan
Letakkan pada samping kanan dan di bawah gambar wayang seperti
pada gambar 3.16.
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Gambar 3.16 Gambar Penempatan Gambar Latar, Wayang, Text Cerita
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Buatlah butfon untuk menuju ke frame 2, yaitu dengan cara mengklik
menu Window > Common Libraries > Buttons. Setelah muncul jendela

seperti seperti pada gambar 3.17, maka pilihlah button yang akan

digunakan dan drag ke area kerja Macromedia Flash.

Ilivl.luuv-m El

P arcade button - orance
¢ 16 [ERAIR

Gambear 3.17 Gambar Jendela Library Buttons

Letakkan pada bagian sebelah kanan. Kemudian buatlah frame sebanyak
10 buah seperti pada gambar 3.18.
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Gambar 3.18 Gambar Penambahan Frame dan Penempatan Button
Sedangkan untuk frame 2 dan selanjutnya kita hanya mengubah isi text
cerita dan menambahkan satu buah butron lagi untuk tombol kembali ke

frame sebelumnya seperti pada gambar 3.19.
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Gambar 3.19 Gambar Pengubahan Isi 7ext Cerita Dan Penambahan

Button

3.3.2.3 Animasi Aksara
Proses pembuatannya adalah dengan mengimport ke /ibrary

Macromedia Flash file - file yang diperlukan untuk membuat animasi
yaitu gambar kuas dan gambar latar. Atur ukuran kertas menjadi 289 x
270 pixel. Kemudian buatlah 4 buah /ayer dengan nama background,
text, path, pena. Beri 40 buah frame setiap layernya. Layer background
digunakan untuk meletakkan gambar latar, /ayer text digunakan untuk
meletakkan tulisan aksara Jawa. Caranya adalah dengan membuat rext
menggunakan Text Tool ( A ) . Pilih font aksara Jawa pada panel
Properties dan ketikkan aksara Jawa ke kertas seperti pada gambar 3.20.
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Gambar 3.20 Gambar Pembuatan Text di Layer Text
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Layer path digunakan untuk meletakkan arah gerak dari kuas. Untuk
membuat arah gerak kuas agar mengikuti bentuk tulisan aksara Jawa
adalah dengan cara menggunakan Pen Tool ( ¢ ). Kemudian klik pada
text dan buat garis mengikuti bentuk tulisannya. Serta buatlah guide
dengan cara klik kanan /ayer path dan pilih Guide seperti pada gambar
321,
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Gambar 3.21 Gambar Pembuatan Arah Gerak Kuas di Layer Path
Layer pena digunakan untuk meletakkan gambar kuas. Agar kuas dapat

bergerak mengikuti bentuk tulisan aksara Jawa maka masukkan gambar

kuas ke area kerja. Buat motion pada layer pena dengan cara mengklik
kanan salah satu frame dari /ayer pena dan klik Create Motion Tween.
Klik gambar kuas dan ubah titik pusat ke ujung kuas dengan
menggunakan [ree Transform Tool ( 21 ). Pada frame 1 layer pena
letakkan gambar kuas pada pojok kiri awal tulisan aksara Jawa dan pada
frame 40 layer pena letakkan gambar kuas pada pojok kiri akhir tulisan
aksara Jawa. Drag layer pena ke /layer path. Seperti pada gambar 3.22.
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Gambar 3.22 Gambar Penempatan Kuas

Kunci semua /ayer kecuali /ayer text dengan cara klik kanan /ayer text
pilih Lock Other. Kemudian tekan tombol Ctr/+B atau klik kanan pada
fext lalu dan klik Break Apart. Tekan tombol F6 untuk membagi frame

pada /ayer text. Hapuslah rext di setiap frame yang telah dibuat secara

berurutan dari belakang dengan menyisakan bagian yang telah dilewati

oleh kuas seperti pada gambar 3.23.
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Gambar 3.23 Gambar Penghapusan 7ext di Setiap Frame

Untuk melihat hasil animasinya adalah dengan cara menekan tombol

Ctrl+Enter atau klik menu control dan pilih Test Movie.
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Gambar 3.24 Gambar Hasil Animasi Aksara

3.3.2.4 Animasi Soal

Proses pembuatannya adalah dengan mengimport ke library
Macromedia Flash file - file yang diperlukan untuk membuat animasi
yaitu gambar latar, gambar dialog, gambar wayang, mulut wayang, dan
tangan wayang. Atur ukuran kertas menjadi 569 x 341 pixel. Drag
gambar kotak dialog, gambar wayang, gambar mulut wayang, dan

gambar tangan wayang ke dalam kertas. Letakkan seperti pada gambar
3.25.
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Gambar 3.25 Gambar Penempatan Gambar Kotak Dialog, Wayang,
Mulut Dan Tangan Wayang

Masukkan button dengan cara mengklik menu Window > Common
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Libraries > Buttons. Setelah muncul jendela seperti di bawah ini, maka
pilihlah button yang akan digunakan dan drag ke area kerja
Macromedia Flash. Letakkan pada bagian sebelah kiri. Kemudian
buatlah fext soal dan jawaban dengan menggunakan 7ext Tool ( A ).
Letakkan text soal pada gambar dialog dan fext jawaban di belakang
button seperti pada gambar 3.26.
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Gambar 3.26 Gambar Penempatan Button dan Text Soal

Sedangkan untuk membuat animasi gerakan mulut dan tangan pada

gambar wayang adalah dengan cara menambahkan frame sebanyak 7
buah pada /ayer, kemudian mengubah posisi dari gambar mulut dan
gambar tangan di setiap frame seperti pada gambar 3.27.
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Gambar 3.27 Gambar Pemindahan Posisi Gambar Mulut dan Tangan
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Untuk melihat hasil animasinya adalah dengan cara menekan tombol

Ctrl+Enter atau klik menu control dan pilih 7est Movie.

He yew Control Hep

ET}BII" odaloh aksaca . . }

Gambar 3.28 Gambar Hasil Animasi Soal

3.3.3 Pengkodean Program
Pengkodean pada aplikasi ini dilakukan dengan menggunakan dua buah
software, yaitu Macromedia Flash dan Borland Delphi.
3.3.3.1 Pengkodean Menggunakan Software Macromedia Flash
Penggunaan sofiware Macromedia Flash adalah sebagai media
pembuatan animasi. Dalam Macromedia Flash terdapat beberapa kode -
kode yang digunakan dalam proses pembuatan aplikasi. Berikut ini
adalah beberapa penggunaan kodenya:
3.3.3.1.1 Menghentikan Animasi
Suatu animasi yang dibuat tanpa diberi script
(perintah) berhenti, dia akan berjalan secara terus menerus tanpa
berhenti. Pemberian script (perintah) berhenti ditujukan agar
animasi tidak berjalan secara terus menerus dan akan berhenti
pada frame yang diberi kode tersebut. Berikut ini adalah contoh
penggunaan script berhenti pada pembuatan aplikasi:
Bukalah project animasi yang telah dibuat sebelumnya

yaitu animasi aksara Jawa Ha seperti pada gambar 3.29.



49

¥

wINCe O~
foawprousriiy

e ]
P

S HON

=

S NINETTTON

Gambar 3.29 Gambar Project Animasi Aksara Jawa Ha

Klik tanda kunci pada /ayer path agar frame dapat diberi script.
Klik frame terakhir dari layer path, yaitu frame 40. Lalu klik
panel Action dan ketikkan script:

Stop ();

[ere———————————————————— v
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(@) operstens {
[A] statements |
[ ActonScript24.. |_
[B) Corpier Drecs... |
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"w- |
E

@ fase Frmmmnante

Gambar 3.30 Gambar Pemberian Script Stop

o

Untuk melihat hasil animasinya adalah dengan cara menekan

tombol Ctri+Enter atau klik menu control dan pilih Test Movie.

Gambar 3.31 Gambar Animasi Aksara Jawa Ha Berhenti pada
Frame Terakhir
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3.3.3.1.2 Berpindah ke Frame Berikutnya

Berikut ini adalah contoh penggunaan script pindah ke
frame berikutnya pada pembuatan aplikasi:

Bukalah project animasi yang telah dibuat sebelumnya
yaitu animasi cerita Ajisaka seperti pada gambar 3.32.
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Gambar 3.32 Gambar Project Animasi Cerita Ajisaka

Klik pada button dan ketikkan script:

on (release)

{
gotoandstop (2);

/

Penjelasan script: on release adalah kejadian (event) yang

dimiliki oleh button saat button ditekan. Jadi di saat button
ditekan maka cursor akan berpindah dan berhenti ke frame
berikutnya

| m ]

P OvE @KL N sai
on (release)
{
gotcandstap (2):
}

Gambar 3.33 Gambar Pemberian Script Pindah ke Frame
Berikutnya
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3.3.3.1.3 Pembuatan Soal

Pembuatan animasi soal pada aplikasi ini
menggunakan beberapa script yang dimiliki Macromedia Flash.
Berikut ini adalah contoh penggunaan scriptnya pada animasi
soal untuk aplikasi ini:

Bukalah project animasi yang telah dibuat
sebelumnya, yaitu animasi soal tingkat pemula seperti pada

gambar 3.34.
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Gambar 3.34 Gambar Project Animasi Soal Tingkat Pemula
Agar animasi berhenti di setiap frame saat dijalankan, klik tiap

frame dari layer dan ketikkan script:

Stop ();

Kemudian klik frame 1 pada layer dan ketikkan script:

stop();
benar = 0;
salah = 0;

fotal_frame = 6;

array frame = [];
Sor (i=2; i<=total_frame; i++) {

array frame.push(i);
/

array_frame.sort(function () {
return random(2) ? 1 : -1;
A

Jjumlah_frame = array frame.length;
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Gambar 3.36 Gambar Pemberian Script pada Button Mulai
Setelah itu klik frame 2 dan pada button - buttonnya ketikkan
script:

a. Script untuk button jawaban benar

on (release) {
benar +=1;
if Gumlah_frame>=0) {
Jumlah frame--;
gotoAndStop(array frame[jumlah_frame]);

}

if Gumlah_frame<0) {
gotoAndStop(7);

/

b. Script untuk button jawaban salah

on (release) {
salah +=1;
if Gumlah_frame>=0) {
Jumlah frame--;
gotoAndStop(array frame[jumlah_frame]);
4
if Gumlah_frame<0) {
gotoAndStop(7);
/

Penjelasan script: on release adalah kejadian (event) yang

dimiliki oleh button saat button ditekan. Jadi di saat button
ditekan maka nilai salah atau benar akan ditambahkan 1.
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Penjelasan script: pemberian nilai benar dan salah dimulai dari
nol, frame yang digunakan sebanyak 6 buah, array yang
digunakan satu dimensi. Pemberian nilai ditandai dengan huruf'i,
dimulai saat button ditekan dan nilainya diset dari 2, apabila i
kurang dari atau sama dengan jumlah frame maka i akan terus
ditambah. Nilai array akan diurutkan mulai frame 2 dan di acak
dengan cara menambahkan satu buah frame atau mengurangi

satu buah frame. Jumlah frame sama dengan jumlah array
keseluruhan.
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Gambar 3.35 Gambar Pemberian Script pada Frame Pertama
Sedangkan untuk button mulai ketikkan script:

on (release) {
Jjumlah frame--;
gotoAndStop(array frame[jumlah _frame]);

Penjelasan script: on release adalah kejadian (event) yang
dimiliki oleh button saat button ditekan. Jadi di saat button
ditekan maka jumlah frame akan dikurangi satu per satu secara
bertahap serta akan menjalankan frame sisa dari pengurangan

tersebut.
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Jika jumlah frame yang telah dikurangi tadi masih ada atau
belum habis, maka jumlah frame akan dikurangi satu per satu
secara bertahap serta akan menjalankan frame sisa dari
pengurangan tersebut dan jika frame yang dikurangi tadi habis,

maka langsung menuju ke frame 7 atau frame terakhir.

@ ¢ el B 02 (12060 (O]

EIEY-E:-X2 X172 s

1 on (release) {

2 benar += 1;

3 if (jumlah frame>=0) {

4 jumlah_ frame--;

5 gotoAndStop (array frame[jumlah frame]):;
[

7

8

9

}
if (jumlah frame<0) {
gotoAndStog (7);
}
10 }

Gambar 3.37 Gambar Pemberian Script pada Button Jawaban
Lanjutkan pemberian script tersebut dengan mengacak
pemberian nilai benar atau salah pada ketiga button di setiap
frame. Sedangkan untuk melihat akumulasi jumlah nilai yang
diperoleh setelah menjawab soal - soal adalah dengan cara
mengklik frame terakhir, yaitu frame 7 dan mengetikkan script
berikut ini:

Stop ();
benar tampil = benar;
salah_tampil = salah;

Penjelasan script: pemberian perintah sfop berfungsi agar
animasi berhenti pada frame ini. Setelah berhenti pada frame

ini, hasil akumulasi nilai benar atau salah akan ditampilkan.
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................

| PpOvE @K
step()?

benar tampil = benar;
salah tampil = salah;

Gambar 3.39 Gambar Akumulasi Nilai Benar dan Salah
Kemudian pada butfon kembali ketikkan script:

on (release) {
gotoAndStop(1);
4

Penjelasan script: on release adalah kejadian (event) yang

dimiliki oleh button saat button ditekan. Jadi di saat button

ditekan maka akan menuju kembali ke frame pertama.

3.3.3.2 Pengkodean Menggunakan Software Borland Delphi

Penggunaan software Borland Delphi adalah sebagai media
pembuatan desain aplikasi. Dalam Borland Delphi terdapat beberapa
kode - kode yang digunakan dalam proses pembuatan aplikasi. Berikut
ini adalah beberapa penggunaan kodenya:
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3.3.3.2.1 Menyembunyikan dan Menampilkan Form atau
Komponen Delphi

Dalam pembuatan aplikasi ini, menyembunyikan form
atau komponen satu dan menampilkan form atau komponen lain
digunakan untuk membedakan form atau komponen delphi yang
aktif dengan yang tidak aktif. Berikut ini adalah contoh
penggunaan script (kode) untuk menyembunyikan dan
menampilkan form pada aplikasi.
Bukalah project dari aplikasi dengan cara klik File > Open
Project > Pilih project Aksara Jawa.dpr > Open. Kemudian
tekan tombol Shifi+F12 pada keyboard. Setelah keluar jendela
View Form, pilih Form_ Aksara_Carakan dan klik tombol OK.

lFotm Aksara_Carakan ILI
Form Akeata Caakan -
Form_Aksara_Rekan o | Cancel |
Form_Aksara_Swara |8 Hop
Form_Angka_Jawa | o |
Form_Certa_Ajsaka | &

Form_Konversi_Aksara_Jawa_Latn | !
Form_Konversi_Latin_Aksara_Jawa i |
Form_Latihan_Aksara_Carakan | §
Form_Latihan_Aksaia_Rekan 13
Form_Latihan_Aksara_Swara I's
Form_Latihan_Angka_Jawa |

Form_Latihan_Pasangan |

Form_Latihan_Sandhangan 14
Form_Latihan_Tanda_Baca | |
Form_Pasangan | |

Form_Tanda_Baca

Form_Tes_Mahi

Form_Tes_Menengah —_
Form_Tes_Pemula (b

Gambar 3.40 Gambar Jendela View Form
Klik dua kali /abel Ha pada form tersebut dan inputkan script:

procedure TForm_Aksara Carakan.HaClick(Sender:
TObject);

begin

Animasi Ha.Show;

Animasi Na.Hide,

Animasi Ca.Hide,

end;

Penjelasan script: saat /abel Ha di klik maka yang muncul
adalah animasi aksara Jawa Ha, sedangkan animasi aksara Jawa

Na dan animasi aksara Jawa Ca akan disembunyikan.
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m

Fintia| F_Mens F_Aksara_Casakan |

procedaore 1'Fnrﬁ_usn:é_&;:;i;;.}i;:llck(5=ndez: TObjece)
begin

Animasi_Ha.Show:

Animasi Na,Hide;

Animasi Ca.Hide;
end;

‘end.

Gambar 3.41 Gambar Pemberian Script Hide dan Show pada
Label Ha di Form Aksara Carakan
Untuk melihat hasilnya adalah dengan cara menjalankan
aplikasi, yaitu dengan menekan tombol F9 pada keyboard.

Carekan / Legena yaitu eksara Jawa pokek yang jumlah
Ke-dua puluh huruf Jowa tersebut adalah sebagal berik

Gambar 3.42 Gambar Animasi Aksara Jawa Setelah Mengklik
Label Ha

3.3.3.2.2 Memanggil File Animasi

Dalam aplikasi ini pemanggilan fi/e animasi dilakukan
pada saat /abe/ di klik dan gunanya adalah sebagai contoh
penulisan aksara. Berikut ini adalah contoh pemanggilan file
animasi pada aplikasi yang dibuat:
Bukalah project dari aplikasi dengan cara klik File > Open
Project > Pilih project Aksara Jawa.dpr > Open. Kemudian
tekan tombol Shifi+F12 pada keyboard. Setelah keluar jendela
View Form, pilih Form_Aksara Carakan dan klik tombol OK.
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Setelah muncul Form_Aksara Carakan, maka klik dua kali pada
label Ca dan ketikkan script:

procedure TForm Aksara Carakan.CaClick(Sender:
TObject),

begin

Animasi_Ca.Show;

With Animasi_Ca do

begin

Movie := _
ExtractPathFile(Application. ExeName)+ 'Animasi\Aksara
Carakan\Ca.swf;

GotoFrame(l);

Play;

end;

Animasi Ha.Hide;

Animasi Na.Hide;

end;

Penjelasan script: saat /abel/ Ca di klik maka yang muncul
adalah animasi aksara Jawa Ca, sedangkan animasi aksara Jawa
Ha dan animasi aksara Jawa Na akan disembunyikan. Dengan
Animasi Ca maka properties movie dari komponen Shockwave
Flash diambil berdasarkan path letak aplikasi dan dalam folder
Animasi >Aksara Carakan dan dengan nama file Ca.swf.

Animasi dimulai dari frame satu dan langsung berjalan.

E F_Aksara_Carakan.pas
F_intto | F_Menu F_Aksara Carakan |
procedure TForm Aksara Carakan.CaClick(Sender: TObject):
'begin
Animasi_Ca.Show;
With Animasi Ca do
begin
Movie = ('D:\Ruliah\Skripsi\Aplikasi\Animasi\Aksara Carakan\Ca.swf'):;
GotoFrame(1):
Play;
end;
Animasi Ha.Hide;
Animasi_la.Hide;
end:

end.

Gambar 3.43 Gambar Pemberian Script Pemanggilan File
Animasi pada Form Aksara Carakan
Untuk melihat hasilnya adalah dengan cara menjalankan
aplikasi, yaitu dengan menekan tombol F9 pada keyboard.
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Gambar 3.44 Gambar Animasi Aksara Jawa Ca yang Muncul
Setelah Label Ca di Klik

3.3.3.2.3 Memanggil File Suara

Dalam aplikasi ini pemanggilan file suara dilakukan
pada saat label di klik dan gunanya adalah sebagai contoh
pembacaan aksara. Berikut ini adalah contoh pemanggilan file
suara pada aplikasi yang dibuat:
Bukalah project dari aplikasi dengan cara klik File > Open
Project > Pilih project Aksara Jawa.dpr > Open. Kemudian
tekan tombol Shifi+F12 pada keyboard. Setelah keluar jendela
View Form, pilih Form_Aksara Carakan dan klik tombol OK.
Setelah muncul Form Aksara Carakan, maka klik dua kali pada
label Na dan ketikkan script:

procedure TForm_Aksara Carakan.NaClick(Sender:
TObject);

begin

PlaySound (PChar ('na’), 0, SND_ASYNC);

end;

Penjelasan script: pada saat /abe/ Na di klik, dia akan
memainkan file musik yang bernama na, ekstensi filenya wave,
dan dimainkan secara asinkron (fungsi kembali bekerja setelah

suara kembali berbunyi mulai dari awal).
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Aksara_Caraka

F_Intro | F_Menu F_Aksara Carakan

' pféc;é;ru TFornLAkrarH_éﬁrékan.NaCllck(Sender: TObiect):
begin

PlaySound (PChar ('na'), 0, SND SYNC):

end;

Gambar 3.45 Gambar Pemberian Script Pemanggilan File Suara
pada Form Aksara Carakan

Lalu pada uses form ketikkan script:

MDMsystem;

Penjelasan script: Mmsystem memberi tanda pada Delphi
bahwa pada form Delphi tersebut menggunakan unit MMsystem
(unit pemutar file suara pada Delphi).

B = sksara Cerskan pas
F_intro| F_Menu F_Aksara_Carakan |

unit F_Ak:arli_tnrnkan:

interface

uses
Windows, Messages, SysUtrils, Variants, Classes, Graphics,
Controls, Forms, Dialogs, E¥RGERASr..gtdCtrls, OleCtrls,
SheckwaveFlashCbjects_TL3B,: MMSystem; E
type
TForm Aksara_Carakan = class (IFoxrm)
Background: TImage:
Aksara Carakan: TLabel;

Gambar 3.46 Gambar Pemberian Script MMSystem pada Uses
Form Aksara Carakan

Untuk melihat hasilnya adalah dengan cara menjalankan

aplikasi, yaitu dengan menekan tombol F9 pada keyboard.

Kemudian klik /abel Na pada Form Aksara Carakan dan

dengarkan suaranya.

3.3.3.2.4 Mengcopy, Menggabungkan, dan Menambah Text
Dalam aplikasi ini, untuk pembuatan form
penerjamahan dari huruf latin ke aksara Jawa ataupun sebaliknya

dari  aksara Jawa ke huruf latin menggunakan metode
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mengcopy, menggabungkan, dan menambah fexr. Berikut ini
adalah contoh penggunaan metode tersebut dalam pembuatan
aplikasi.

Bukalah project dari aplikasi dengan cara klik File > Open
Project > Pilih project Aksara Jawa.dpr > Open. Kemudian
tekan tombol Shifi+F12 pada keyboard. Setelah keluar jendela
View Form, pilih Form_Konversi L A dan klik tombol OK.
Setelah muncul Form_ Konversi LA, maka klik pada Memo
Latin, lalu pada panel Object Inspector pilih tab Events dan klik
dua kali pada event OnChange seperti pada gambar 3.47.

Latin TMeme -
Propetties Eml

fl OnChange |[ETLTTNTH vl
OnClick | ]
OnContextPopt t
OnDbiClick |
OnDragDrop

OnDiagOver

OnEndDock |
OnEndDrag |
OnEnter |
OnEst |
OnKeyDown |
OnKeyPress |
OnKeyUp | |
OnMouseDowr !
OnMouseMove '
OnMouseUp

OnStatDock. |
OnStatDrag |+
All shown

m

Gambar 3.47 Gambar Event OnChange pada Panel Object
Inspector

Kemudian ketikkanlah script:

procedure

TForm Konversi Latin Aksara Jawa.LatinChange(Sender:
TObject);

var

index huruf : string;

begin

if index huruf="o" then

Aksara Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara
_Jawa.Text)-

1)+"["+copy(Aksara Jawa.Text,length(Aksara Jawa.Text),2)
+0’

end;
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Penjelasan script: variabel index huruf digunakan untuk
menentukan bahwa yang diinputkan ke dalam Memo Latin
adalah berbentuk string (kata). Kemudian jika yang diinputkan
pada kata terakhir (index huruf) adalah huruf “0”, maka pada
Memo Aksara Jawa akan dicopy kata yang telah diinputkan
mulai dari awal hingga terakhir, kemudian diberi karakter "[”
dan dituliskan kembali pada Memo Aksara_Jawa kata yang telah
dicopy sebanyak 2 karakter serta akan ditambah huruf 0” di

akhir katanya.

Finho F_Komversi LA | -
procedure Irutm_kcnve=sl_Lntxn_Aksirﬁ;:;u;:iseihihnnqeiScndet: IObjech;““_ o ff
var
index_huruf : string:
rbegin
Ii{ index_huzuf='c' then
|Aksara_Jawa.Text:=copy (Aksara_Jawa.Text, 0,lengch (Rksara Jawa.Text)-1)+'["+copy(R

end;

L - 2

192 5§ |Modhed  |Inset \Code {Diagram / LT

-

Gambar 3.48 Gambar Pemberian Script Copy Text

Untuk melihat hasilnya adalah dengan cara menjalankan
aplikasi, yaitu dengan menekan tombol F9 pada keyboard. Untuk
percobaan kita inputkan kata “mo”. Hasilnya adalah pada Memo
Aksara_Jawa sebelum kata “m” diberi karakter ”[” dan setelah
kata ”m” ditambah huruf ”0”. Hasil percobaan yang pada Memo
Aksara_Jawa textnya telah dirubah menjadi fext aksara Jawa
ditunjukkan seperti pada gambar 3.49.

Gambar 3.49 Gambar Hasil Percobaan
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Teknik ini pada intinya adalah digunakan untuk membaca setiap
karakter huruf latin yang diinputkan atau diketikkan ke text area
latin dan akan dirubah ke aksara Jawa. Contohnya pembacaan
kata “siku”. Pembacaannya dimulai dengan membaca huruf ”s”

yang akan dirubah ke aksara Jawa menggunakan script:

if inda.x_hunf= 's' then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara
_Jawa.Text))+'s\" else

Penjelasan script: jika index huruf (huruf terakhir) yang
diketikkan pada fext area latin adalah huruf ”s”, maka pada text
area aksara Jawa akan dicopi textnya mulai dari awal dan akan
ditambahkan huruf ”’s\” di bagian akhir text yang telah dicopi.

Kemudian pembacaan ditujukan pada karakter setelah huruf ”’s”,
yaitu huruf “i” dan akan dirubah ke aksara Jawa dengan

memanggil procedure perintah:

procedure TForm_Konversi_Latin_Aksara_Jawa.i;

begin

Aksara_Jawa.Text:=
copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'i';
end;

if (i ind.ex_hurzf= i) then i;

Penjelasan script: prosedur huruf i, yaitu prosedur untuk rext
area aksara Jawa yang akan dicopi textnya mulai dari awal dan
akan ditambahkan huruf ”i” di bagian akhir fext yang telah
dicopi. Prosedur ini akan dijalankan apabila index huruf (huruf
terakhir) yang diketikkan pada text area latin adalah huruf ”i”.
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Setelah itu pembacaan ditujukan akan dilakukan pada karakter
setelah huruf ’s” dan “i”, yaitu huruf ”k” dan akan dirubah ke
aksara Jawa menggunakan script:

if inde;c_hur14f= 'k’ then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara
_Jawa.Text))+'k\' else

Penjelasan script: jika index huryf (huruf terakhir) yang
diketikkan pada text area latin adalah huruf k”, maka pada text
area aksara Jawa akan dicopi textnya mulai dari awal dan akan
ditambahkan huruf ”’k\” di bagian akhir zext yang telah dicopi.

Dan terakhir pembacaan ditujukan pada karakter setelah huruf
”s”,”i”, dan “k”, yaitu huruf “u” dan akan dirubah ke aksara

Jawa dengan memanggil procedure perintah:

procedure TForm_Konversi_Latin_Aksara_Jawa.u;

begin

Aksara_Jawa.Text:=
copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+u’;
end;

if (index_huruf="d') then u;

Penjelasan script: prosedur buruf u, yaitu prosedur untuk fext
area aksara Jawa yang akan dicopi textnya mulai dari awal dan
akan ditambahkan huruf ”u” di bagian akhir fext yang telah
dicopi. Prosedur ini akan dijalankan apabila index_huruf (huruf
terakhir) yang diketikkan pada fext area latin adalah huruf u”.
Hasil terjemahan keseluruhannya akan menjadi:

siku = rﬁmﬂlj
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3.3.4 Perekaman Suara

Proses perekaman suara pada aplikasi ini menggunakan soffware Adobe
Audition. Alat perekam suara pada aplikasi ini menggunakan microphone.
Berikut ini adalah contoh perekaman suara cara pembacaan aksara Jawa untuk
aplikasi yang dibuat.
Bukalah sofiware Adobe Audition. Kemudian klik menu File > New untuk
membuat file rekaman baru. Lalu klik tombol Rec ( ) pada Panel Transport
dan akan muncul jendela seperti pada gambar 3.50.

o || OMono O gbit
: — | | @ Stereo @ 16-bit
<l O 325t (foat)

-
-
o
~N
w
|

Gambar 3.50 Gambar Jendela New Waveform
Pilih 44100 pada Sample Rate, Stereo pada Channels, dan 16-Bit pada
Resolution dan tekan tombol OK. Kemudian akan muncul jendela rekam dan
segeralah mulai proses perekaman suara melalui microphone. Unuk
mengakhiri proses perekaman tekanlah tombol Stop ( ). Gambar 3.51

adalah jendela rekam Adobe Audition yang telah berisi suara rekaman.

Gambar 3.51 Gambar Jendela Rekam Adobe Audition yang Telah Terisi Suara
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Kemudian simpan file suara rekaman tersebut dengan cara menyeleksi yang
memiliki gelombang suara pada jendela rekam, lalu klik kanan dan pilih Save

Selection.. seperti pada gambar 3.52.

[ Select View
Select Entire Wave Ctri+A

| Insert Into Multitrack Ctrl+M

Clrl+X
Copy Clrl+C
Copy To New
Pasts Ctrl4
Mix Paste... Ctri+5shift+V
Tt CorlT
Mute
Add to Marker List

Preroll and Postroll Options...
File Info...

P g == T S s e e e e e -

Gambar 3.52 Gambar Cara Menyimpan Hasil Rekaman Suara
Kemudian akan muncul jendela Save Selection dan simpan dengan nama

Tha.wav seperti pada gambar 3.53.

Rocer Foldow, |C:\Docuers andSetinge WISl Documerts 0
| [ 8] untted J Cybertink - | S 35en i
| wendi | Cerita Ajsaka I e 35348 ‘
||| Updater | anmadu
. New Folder . AdobeStockPhotos “ Temp Dir |
|| B My videos i Adobe
| gmm |
| & MyPictures
|| My Musie
||y Rash-swf-converter |
| i Downioads |
: i
i |
Fie pame i{h‘;.__.._ B - Save ] |
| Saveasppe: Windows PCM (wavi"bwl) o [, |
[V Save extra non-audio information -_Gphuu E:M: |

Gambar 3.53 Gambar Jendela Save Selection
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3.4 Desain Antarmuka Aplikasi
Berikut ini adalah desain antarmuka dari aplikasi yang telah dibuat:
A. Desain Halaman Intro
Halaman ini terdiri dari judul aplikasi, animasi intro dan sebuah tombol

menu. Desain halaman ini ditunjukkan oleh gambar 3.54.

Animasi
Intro

Tombol Menu

Gambar 3.54 Gambar Desain Halaman Intro

B. Desain Halaman Menu Utama
Halaman ini terdiri dari 5 buah menu utama beserta sub menunya dan

sebuah tombol keluar. Desain halaman ini ditunjukkan oleh gambar 3.55.

Menul| Menu2 | Menu 3 Menu 4 Menu 5

Sub Sub Sub Sub Sub
Menul | Menu2 | Menu 3 Menu 4 Menu 5

Tombel Exit

Gambar 3.55 Gambar Desain Halaman Menu Utama
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Berikut ini adalah desain halaman sub menu dari setiap menu:

a. Sejarah
Menu ini hanya memiliki satu buah sub menu, yaitu Cerita Ajisaka.
Halaman Cerita Ajisaka ini terdiri dari judul halaman, animasi cerita
Ajisaka dan sebuah tombol keluar. Desain halaman ini ditunjukkan
oleh gambar 3.56.

Judul Halaman

Animasi Cerita

Tombol Exit

Gambar 3.56 Gambar Desain Halaman Cerita Ajisaka

b. Pembelajaran
Menu ini memiliki tujuh buah sub menu, yaitu Aksara Carakan,
Pasangan, Sandhangan, Angka Jawa, Aksara Swara, Aksara Rekan,
dan Tanda Baca. Ketujuh halaman tersebut terdiri dari judul halaman,
penjelasan mengenai aksara, tombol — tombol nama aksara, animasi
cara penulisan aksara, contoh penggunaan aksara beserta cara
penulisanya, dan tombol keluar. Desain halaman ini ditunjukkan oleh

gambar 3.57.
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Judul Halaman

Penjelasan Aksara

Contoh Penggunaan
Aksara
Tombol Animasi
Nama Cara Animasi Cara
: Penulisan Aksara
—— o Berdasarkan Contoh
Aksara

Tombel Exit

Gambar 3.57 Gambar Desain Halaman Pembelajaran

¢. Penerjemahan
Menu ini memiliki dua buah sub menu, yaitu Latin — Aksara Jawa dan
Aksara Jawa — Latin.
a. Halaman Latin — Aksara Jawa
Halaman ini terdiri dari judul halaman, dua buah text area (text
area latin dan text area aksara Jawa), dan empat buah tombol

(tombol huruf é, tombol kosongkan, tombol terjemahkan, dan

tombol keluar). Desain halaman ini ditunjukkan oleh gambar 3.58.

Judul Halaman

tombol é | | tombol kosongkan || tombol terjemahkan

Text area Latin

Text area Aksara Jawa

Tombel Exit

Gambar 3.58 Gambar Desain Halaman Penerjemahan Latin —

Aksara Jawa
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b. Halaman Aksara Jawa — Latin
Halaman ini terdiri dari judul halaman, sebuah panel tombol aksara
Jawa, dua buah text area (text area aksara Jawa dan text area latin),
dan tiga buah tombol (tombol terjemahkan, tombol kosongkan, dan

tombol keluar). Desain halaman ini ditunjukkan oleh gambar 3.59.

Judul Halaman

Panel Tombol Aksara Jawa

Text area Aksara Jawa

tombol kosongkan || tombol terjemahkan

Text area Latin

Tembel Exit

Gambar 3.59 Gambar Desain Halaman Penerjemahan Aksara

Jawa — Latin

d. Latihan
Menu ini memiliki tujuh buah sub menu, yaitu Aksara Carakan,
Pasangan, Sandhangan, Angka Jawa, Aksara Swara, Aksara Rekan,
dan Tanda Baca. Ketujuh halaman tersebut terdiri dari tiga buah
tombol tingkatan soal, yaitu tingkat pemula, menengah, dan mahir
serta sebuah tombol keluar. Desain halaman ini ditunjukkan oleh

gambar 3.60.
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Judul Halaman

Tombol Tingkatan Soal

Animasi Soal

Tombel Exit

Gambar 3.60 Gambar Desain Halaman Latihan

e. Tes
Menu ini memiliki tiga buah sub menu, yaitu pemula, menengah, dan
mahir. Ketiga halaman tersebut terdiri dari judul halaman, animasi soal
berdasarkan tingkatan, dan sebuah tombol keluar. Desain halaman ini

ditunjukkan oleh gambar 3.61.

Judul Halaman

Animasi Soal

Tombel Exit

Gambar 3.61 Gambar Desain Halaman Tes



BAB IV
IMPLEMENTASI DAN PENGUJIAN SISTEM

4.1 Implementasi Sistem
Dalam pengemplemantasian ini akan diperoleh beberapa data yang bersifat
informasi tentang bisa atau tidaknya sistem bekerja beserta kelemahanya. Dalam
hal ini pengujian dilakukan hanya pada PC/Laptop yang didalamanya telah
terinstal Adobe Flash Player.
Untuk melakukan pengujian aplikasi Pembelajaran Aksara Jawa Berbasis
Multimedia, digunakan sebuah PC/Laptop dengan spesifikasi hardware:
a) Prosesor Intel Celeron 1,73 GHz
b) RAM1GB
¢) Sistem Operasi yang digunakan Windows XP
d) VGA ATI-RADEON memory 256 MB

4.2 Pengujian Sistem
4.2.1 Halaman Intro
Halaman ini berisi tentang animasi pembuka dari aplikasi dan sebuah

tombol menu yang jika ditekan akan memunculkan halaman menu utama.

Tampilan halamannya seperti pada gambar 4.1.
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Gambar 4.1 Gambar Tampilan Halaman Intro
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4.2.2 Halaman Menu Utama

Halaman ini berisi tentang lima buah menu beserta beberapa sub

menunya dan tampilan halamannya seperti pada gambar 4.2.

a.

Menu Sejarah

Menu ini memiliki sebuah sub menu, yaitu Cerita Ajisaka.

Menu Pembelajaran

Menu ini memiliki tujuh buah sub menu, yaitu Aksara Carakan, Pasangan,
Sandhangan, Angka Jawa, Aksara Swara, Aksara Rekan, dan Tanda Baca.
Menu Penerjemahan

Menu ini memiliki dua buah sub menu, yaitu Latin — Aksara Jawa dan
Aksara Jawa — Latin.

Menu Latihan

Menu ini memiliki tujuh buah sub menu, yaitu Aksara Carakan, Pasangan,
Sandhangan, Angka Jawa, Aksara Swara, Aksara Rekan, dan Tanda Baca.
Menu Tes

Menu ini memiliki tiga buah sub menu, yaitu Pemula, Menengah, dan
Mabhir
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Gambar 4.2 Gambar Tampilan Halaman Menu Utama
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4.2.3 Halaman Cerita Ajisaka

Halaman ini berisi animasi cerita Ajisaka, yaitu cerita mengenai awal
mula atau asal — usul dari aksara Jawa dan diiringi musik jawa. Untuk
melanjutkan ke halaman cerita selanjutnya maka klik tombol next. Sedangkan
tombol exit digunakan untuk keluar dari halaman cerita Ajisaka dan kembali

ke menu utama. Tampilan halamannya seperti pada gambar 4.3.

Gambar 4.3 Gambar Tampilan Halaman Cerita Ajisaka

4.2.4 Halaman Pembelajaran Aksara Carakan

Halaman ini adalah bagian dari menu pembelajaran yang berisi
penjelasan aksara carakan, tombol — tombol nama aksara yang jika ditekan
akan memunculkan suara cara pembacaan aksara, animasi cara penulisan
aksara, dan contoh penggunaan aksara. Di dalamnya juga terdapat sebuah
tombol bergambar pensil yang jika ditekan akan memunculkan animasi contoh
penulisan aksara berdasarkan contoh penggunaan aksara. Sedangkan tombol
exit digunakan untuk keluar dari halaman pembelajaran aksara carakan dan

kembali ke menu utama. Tampilan halamannya seperti pada gambar 4.4.
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Gambar 4.4 Gambar Tampilan Halaman Aksara Carakan

4.2.5 Halaman Pembelajaran Pasangan

Halaman ini adalah bagian dari menu pembelajaran yang berisi
penjelasan pasangan, tombol — tombol nama pasangan yang jika ditekan akan
memunculkan suara cara pembacaan pasangan, animasi cara penulisan
pasangan, dan contoh penggunaan pasangan. Di dalamnya juga terdapat
sebuah tombol bergambar pensil yang jika ditekan akan memunculkan animasi
contoh penulisan pasangan berdasarkan contoh penggunaan pasangan.
Sedangkan tombol exit digunakan untuk keluar dari halaman pembelajaran
pasangan dan kembali ke menu utama. Tampilan halamannya seperti pada

gambar 4.5.
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Gambar 4.5 Gambar Tampilan Halaman Pasangan

4.2.6 Halaman Pembelajaran Sandhangan

Halaman ini adalah bagian dari menu pembelajaran yang berisi
penjelasan sandhangan, tombol — tombol nama sandhangan yang jika ditekan
akan memunculkan suara cara pembacaan nama sandhangan, animasi cara
penulisan sandhangan, dan contoh penggunaan sandhangan. Di dalamnya juga
terdapat sebuah tombol bergambar pensil yang jika ditekan akan
memunculkan animasi contoh penulisan sandhangan berdasarkan contoh
penggunaan sandhangan. Sedangkan tombol exir digunakan untuk keluar dari
halaman pembelajaran sandhangan dan kembali ke menu utama. Tampilan

halamannya seperti pada gambar 4.6.
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Gambar 4.6 Gambar Tampilan Halaman Sandhangan

4.2.7 Halaman Pembelajaran Angka Jawa

Halaman ini adalah bagian dari menu pembelajaran yang berisi
penjelasan angka Jawa, tombol — tombol anggka yang jika ditekan akan
memunculkan suara cara pembacaan angka Jawa, animasi cara penulisan
angka, dan contoh penggunaan angka. Di dalamnya juga terdapat sebuah
tombol bergambar pensil yang jika ditekan akan memunculkan animasi contoh
penulisan angka berdasarkan contoh penggunaan angka. Sedangkan tombol
exit digunakan untuk keluar dari halaman pembelajaran angka Jawa dan

kembali ke menu utama. Tampilan halamannya seperti pada gambar 4.7.
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Gambar 4.7 Gambar Tampilan Halaman Angka Jawa

4.2.8 Halaman Pembelajaran Aksara Swara

Halaman ini adalah bagian dari menu pembelajaran yang berisi
penjelasan aksara swara, tombol — tombol nama aksara yang jika ditekan akan
memunculkan suara cara pembacaan aksara, animasi cara penulisan aksara,
dan contoh penggunaan aksara. Di dalamnya juga terdapat sebuah tombol
bergambar pensil yang jika ditekan akan memunculkan animasi contoh
penulisan aksara berdasarkan contoh penggunaan aksara. Sedangkan tombol
exit digunakan untuk keluar dari halaman pembelajaran aksara swara dan
kembali ke menu utama. Tampilan halamannya seperti pada gambar 4.8.
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Gambar 4.8 Gambar Tampilan Halaman Aksara Swara

4.2.9 Halaman Pembelajaran Aksara Rekan

Halaman ini adalah bagian dari menu pembelajaran yang berisi
penjelasan aksara rekan, tombol — tombol nama aksara yang jika ditekan akan
memunculkan suara cara pembacaan aksara, animasi cara penulisan aksara,
dan contoh penggunaan aksara. Di dalamnya juga terdapat sebuah tombol
bergambar pensil yang jika ditekan akan memunculkan animasi contoh
penulisan aksara berdasarkan contoh penggunaan aksara. Sedangkan tombol
exit digunakan untuk keluar dari halaman pembelajaran aksara rekan dan
kembali ke menu utama. Tampilan halamannya seperti pada gambar 4.9.
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Gambar 4.9 Gambar Tampilan Halaman Aksara Rekan

4.2.10 Halaman Pembelajaran Tanda Baca

Halaman ini adalah bagian dari menu pembelajaran yang berisi
penjelasan tanda baca, tombol — tombol nama tanda baca yang jika ditekan
akan memunculkan suara cara pembacaan nama tanda baca, animasi cara
penulisan tanda baca, dan contoh penggunaan tanda baca. Di dalamnya juga
terdapat sebuah tombol bergambar pensil yang jika ditekan akan
memunculkan animasi contoh penulisan tanda baca berdasarkan contoh
penggunaan tanda baca. Sedangkan tombol exit digunakan untuk keluar dari
halaman pembelajaran tanda baca dan kembali ke menu utama. Tampilan
halamannya seperti pada gambar 4.10.
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Gambar 4.10 Gambar Tampilan Halaman Tanda Baca

4.2.11 Halaman Penerjemah Latin — Aksara Jawa

Halaman ini adalah bagian dari menu penerjemahan yang berisi dua
buah fext area, yaitu text area latin (text area yang digunakan untuk
menuliskan huruf latin) dan rext area aksara Jawa (fext area hasil dari
terjemahan). Empat buah tombol, yaitu tombol huruf ” ¢ ” (tombol yang jika
ditekan akan menambahkan huruf ” é ” pada fext area latin), tombol
kosongkan (tombol yang jika ditekan akan membersihkan kedua text area),
tombol terjemahkan (tombol yang jika ditekan akan melakukan proses
penerjemahan huruf latin ke aksara Jawa), dan tombol exit (tombol yang jika
ditekan akan menutup halaman penerjemah latin — aksara Jawa dan kembali ke
menu utama). Tampilan halamannya seperti pada gambar 4.11.
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Gambar 4.11 Gambar Tampilan Halaman Penerjemah Latin — Aksara Jawa

Hasil pengujian penerjemahan Latin — Aksara Jawa yang lainnya dapat dilihat
pada tabel 4.1.

Tabel 4.1 Tabel Pengujian Penerjemahan Latin — Aksara Jawa

Hasil
No Huruf Latin Aksara Jawa
Penerjemahan
/
1 | jakarta L Sesuai
meja komputeritu | €3, ﬂ'lﬂﬁﬂ?. 0 Jl)ﬂ?u/ W %ﬁ/
berwarna biru
2 . Tidak sesuai
fl]Tl;]‘flﬂ]TlJ
1 o O o
Ajisaka  adalah | 002 amsmmany3 g
pencipta  Aksara R
3 | Jawa. Dia adalah Sesuai
ksatria sakti dari | GAHBNATIKWIW AN

pulau majethi dan
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mempunyai  dua | masney AdiAmAAANATI
Qs S NAAANATIY
orang  punggawa
yang setia yaitu 6 o o
Dora dan ﬂlﬂflﬂl]ftﬂflKﬂSﬂJﬂflﬂﬂgftﬂ%ﬂ{l
Sembadha. Aksara
Jawa diciptakannya m‘r’mqjmnn]nmzﬁmbn.mmm"rfn
untuk mengenang m
kesetiaan dua . . o
punggawanya nmmnmmmnmrhnlwzmnmrm
tersebut
QAR édmm,omngnmﬁa\?mag
s nAAns
g e
ANO
mnmnng,mmmnmanm fclﬂ[l,”llJ
s
a A mAT
4 | mlebu kabéh . ”fl] "l % Sesuai
5 | quit JUS Tidak sesuai
6 | 1945 :Mmea : Sesuai

Beberapa pengujian ini telah menghasilkan penerjemahan yang tidak sesuai.
Untuk yang pertama adalah dikarenakan dalam aksara Jawa terdapat dua buah
pembacaan untuk huruf e, yaitu ”e” dan “é”. Seperti contoh pada tabel di atas,
penulisan kata “meja komputer itu berwarna biru”. Ketidaksesuaiannya
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dikarenakan penulisan kata “meja” yang sebenarnya harus ditulis “méja”.
Setelah kata tersebut dirubah menjadi yang sebenarnya atau sesuai, maka

hasilnya akan menjadi seperti di bawah ini:

méja komputer itu berwarna biru = [TIRﬂﬂKﬂ]ﬂ'EﬂlﬁﬂJhﬂﬁ{mﬁ ﬂﬂljﬂ?ﬂ/ﬂﬂgﬂﬁ]m

Sedangkan untuk yang kedua adalah aksara Jawa tidak mengenal huruf “q”

2,77

dan 7x”. Seperti contoh pada tabel di atas, yaitu kata “quit”.

Ketidaksesuaiannya dikarenakan dalam penulisan aksara Jawanya (UJ'lﬂ'IﬂéTIJ] )

tidak sesuai dengan aturan penulisan aksara Jawa, yaitu untuk awal dari
penulisan suatu kata harus diawali dengan aksara carakan dan tidak boleh

berupa sandhangan.

4.2.12 Halaman Penerjemah Aksara Jawa — Latin

Halaman ini adalah bagian dari menu penerjemahan yang berisi dua
buah fext area, yaitu text area aksara Jawa (fext area yang digunakan untuk
menuliskan aksara Jawa) dan text area latin (fext area hasil dari terjemahan).
Sebuah panel tombol aksara (panel yang berisi tombol — tombol aksara Jawa
dan digunakan untuk menginputkan aksara Jawa ke fext area aksara Jawa),
dan tiga buah tombol, yaitu tombol kosongkan (tombol yang jika ditekan akan
membersihkan kedua text area), tombol terjemahkan (tombol yang jika
ditekan akan melakukan proses penerjemahan aksara Jawa ke huruf latin), dan
tombol exit (tombol yang jika ditekan akan menutup halaman penerjemah latin
— aksara Jawa dan kembali ke menu utama). Tampilan halamannya seperti

pada gambar 4.12,
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Gambar 4.12 Gambar Tampilan Halaman Penerjemah Aksara Jawa — Latin

Hasil pengujian penerjemahan Aksara Jawa — Latin yang lainnya dapat dilihat
pada tabel 4.2.
Tabel 4.2 Tabel Pengujian Penerjemahan Aksara Jawa — Latin

Hasil
No Aksara Jawa Huruf Latin )
Penerjemahan
1 IR mahabarata Sesuai
o O o 3 2
@:‘Hlﬂ%(iﬂ rmm ﬂlﬂ'ITlJﬂKrlJl Asihbernyanyilag :
2 . Sesuai
ujawa
o O + O /O ; .
GAMAN H'lfUllZTI UIMINK ANMIAN: | Aniseorangpelajar
kelas6sekolahdasa
o i = % r.sedangkanAliseo
3 A ﬂlf}ETIZ ﬂlﬂ%ﬂ.ﬂﬂ.ﬂ el rangpelajarkelas5 Sesuai
sekolahdasar.kedu
o O « O /O
GAMNRN IT|ﬂJl12TI MAmANK pnmanm | anyaanakyangeerd

as.merekaselalunai
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7

AN:G): gc_)n "]ﬂmlﬂlﬂ%ﬂ.llﬂjl Nfﬂ?l m'] kkelasdanmendap

atperingkatsatu.
X o

mnn;umnrmngnm INEL YA nl'n[}m

i fns magmig sann

m mnm{h"ﬂm“ nfllESTIL "m «y Cw

Q oe

mamn ﬂﬂlﬂ.ﬂl;ﬂﬂ.ﬂbu

O e banyukali Sesuai
/ oe

s | working Sesuai
2 R 11juli1987 Sesuai

Hasil penerjemahan akan selalu sesuai berdasarkan aksara Jawa yang
diinputkan atau dimasukkan ke fext area aksara Jawa dan dalam hasil
terjemahannya tidak terdapat spasi antar kalimat yang dikarenakan aksara
Jawa tidak mengenal karakter spasi. Sehingga hasilnya sesuai berdasarkan
aturan penulisan aksara Jawa dan tidak sesuai dengan aturan penulisan huruf

latin.

4.2.13 Halaman Latihan Aksara Carakan

Halaman ini adalah bagian dari menu latihan yang berisi tiga buah
tombol tingkatan soal, yaitu Pemula, Menengah, dan Mahir yang apabila
tombol — tombol tersebut ditekan maka akan memunculkan animasi soal
latihan aksara carakan (soal berjumlah lima buah dan akan selalu diacak)
berdasarkan tingkatan yang telah dipilih dan sebuah tombol exir (tombol yang
jika ditekan akan menutup halaman latihan aksara carakan dan kembali ke
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menu utama). Proses pemberian score atau nilai dilakukan setelah user atau
pengguna selesai menjawab lima buah soal yang diberikan. Hasil akumulasi
score atau nilai akan ditampilkan dalam bentuk jumlah jawaban salah dan

jumlah jawaban benar. Tampilan halamannya seperti pada gambar 4.13.

Gambar 4.13 Gambar Tampilan Halaman Latihan Aksara Jawa

4.2.14 Halaman Latihan Pasangan

Halaman ini adalah bagian dari menu latihan yang berisi tiga buah
tombol tingkatan soal, yaitu Pemula, Menengah, dan Mahir yang apabila
tombol — tombol tersebut ditekan maka akan memunculkan animasi soal
latihan pasangan (soal berjumlah lima buah dan akan selalu diacak)
berdasarkan tingkatan yang telah dipilih dan sebuah tombol exif (tombol yang
jika ditekan akan menutup halaman latihan pasangan dan kembali ke menu
utama). Proses pemberian score atau nilai dilakukan setelah wser atau
pengguna selesai menjawab lima buah soal yang diberikan. Hasil akumulasi
score atau nilai akan ditampilkan dalam bentuk jumlah jawaban salah dan

jumlah jawaban benar. Tampilan halamannya seperti pada gambar 4.14.
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Gambar 4.14 Gambar Tampilan Halaman Latihan Pasangan

4.2.15 Halaman Latihan Sandhangan

Halaman ini adalah bagian dari menu latihan yang berisi tiga buah
tombol tingkatan soal, yaitu Pemula, Menengah, dan Mahir yang apabila
tombol — tombol tersebut ditekan maka akan memunculkan animasi soal
latihan sandhangan (soal berjumlah lima buah dan akan selalu diacak)
berdasarkan tingkatan yang telah dipilih dan sebuah tombol exit (tombol yang
jika ditekan akan menutup halaman latihan sandhangan dan kembali ke menu
utama). Proses pemberian score atau nilai dilakukan setelah wuser atau
pengguna selesai menjawab lima buah soal yang diberikan. Hasil akumulasi
score atau nilai akan ditampilkan dalam bentuk jumlah jawaban salah dan
jumlah jawaban benar. Tampilan halamannya seperti pada gambar 4.15.
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Gambar 4.15 Gambar Tampilan Halaman Latihan Sandhangan

4.2.16 Halaman Latihan Angka Jawa

Halaman ini adalah bagian dari menu latihan yang berisi tiga buah
tombol tingkatan soal, yaitu Pemula, Menengah, dan Mahir yang apabila
tombol — tombol tersebut ditekan maka akan memunculkan animasi soal
latihan angka Jawa (soal berjumlah lima buah dan akan selalu diacak)
berdasarkan tingkatan yang telah dipilih dan sebuah tombol exit (tombol yang
jika ditekan akan menutup halaman latihan angka Jawa dan kembali ke menu
utama). Proses pemberian score atau nilai dilakukan setelah wser atau
pengguna selesai menjawab lima buah soal yang diberikan. Hasil akumulasi
score atau nilai akan ditampilkan dalam bentuk jumlah jawaban salah dan

jumlah jawaban benar. Tampilan halamannya seperti pada gambar 4.16.
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Gambar 4.16 Gambar Tampilan Halaman Latihan Angka Jawa

4.2.17 Halaman Latihan Aksara Swara

Halaman ini adalah bagian dari menu latihan yang berisi tiga buah
tombol tingkatan soal, yaitu Pemula, Menengah, dan Mahir yang apabila
tombol — tombol tersebut ditekan maka akan memunculkan animasi soal
latihan aksara swara (soal berjumlah lima buah dan akan selalu diacak)
berdasarkan tingkatan yang telah dipilih dan sebuah tombol exit (tombol yang
jika ditekan akan menutup halaman latihan aksara swara dan kembali ke menu
utama). Proses pemberian score atau nilai dilakukan setelah wser atau
pengguna selesai menjawab lima buah soal yang diberikan. Hasil akumulasi
score atau nilai akan ditampilkan dalam bentuk jumlah jawaban salah dan
Jjumlah jawaban benar. Tampilan halamannya seperti pada gambar 4.17.
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Gambar 4.17 Gambar Tampilan Halaman Latihan Aksara Swara

4.2.18 Halaman Latihan Aksara Rekan

Halaman ini adalah bagian dari menu latihan yang berisi tiga buah
tombol tingkatan soal, yaitu Pemula, Menengah, dan Mahir yang apabila
tombol — tombol tersebut ditekan maka akan memunculkan animasi soal
latthan aksara rekan (soal berjumlah lima buah dan akan selalu diacak)
berdasarkan tingkatan yang telah dipilih dan sebuah tombol exir (tombol yang
jika ditekan akan menutup halaman latihan aksara rekan dan kembali ke menu
utama). Proses pemberian score atau nilai dilakukan setelah wuser atau
pengguna selesai menjawab lima buah soal yang diberikan. Hasil akumulasi
score atau nilai akan ditampilkan dalam bentuk jumlah jawaban salah dan

Jjumlah jawaban benar. Tampilan halamannya seperti pada gambar 4.18.



92

Gambar 4.18 Gambar Tampilan Halaman Latihan Aksara Rekan

4.2.19 Halaman Latihan Tanda Baca

Halaman ini adalah bagian dari menu latihan yang berisi tiga buah
tombol tingkatan soal, yaitu Pemula, Menengah, dan Mahir yang apabila
tombol — tombol tersebut ditekan maka akan memunculkan animasi soal
latihan tanda baca (soal berjumlah lima buah dan akan selalu diacak)
berdasarkan tingkatan yang telah dipilih dan sebuah tombol exit (tombol yang
jika ditekan akan menutup halaman latihan tanda baca dan kembali ke menu
utama). Proses pemberian score atau nilai dilakukan setelah wuser atau
pengguna selesai menjawab lima buah soal yang diberikan. Hasil akumulasi
score atau nilai akan ditampilkan dalam bentuk jumlah jawaban salah dan
jumlah jawaban benar. Tampilan halamannya seperti pada gambar 4.19.
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Gambar 4.19 Gambar Tampilan Halaman Latihan Tanda Baca

4.2.20 Halaman Tes Tingkat Pemula

Halaman ini adalah bagian dari menu tes yang berisi animasi soal tes
untuk tingkat pemula (soal berjumlah sepuluh buah, diambil dari soal — soal
latihan tingkat pemula, dan akan selalu diacak) dan sebuah tombol exit
(tombol yang jika ditekan akan menutup halaman tes tingkat pemula dan
kembali ke menu utama). Proses pemberian score atau nilai dilakukan setelah
user atau pengguna selesai menjawab sepuluh buah soal yang diberikan. Hasil
akumulasi score atau nilai akan ditampilkan dalam bentuk jumlah jawaban
salah dan jumlah jawaban benar. Tampilan halamannya seperti pada gambar
4.20.
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Gambar 4.20 Gambar Tampilan Halaman Tes Tingkat Pemula

4.2.21 Halaman Tes Tingkat Menengah

Halaman ini adalah bagian dari menu tes yang berisi animasi soal tes
untuk tingkat menengah (soal berjumlah sepuluh buah, diambil dari soal — soal
latihan tingkat menengah, dan akan selalu diacak) dan sebuah tombol exir
(tombol yang jika ditekan akan menutup halaman tes tingkat menengah dan
kembali ke menu utama). Proses pemberian score atau nilai dilakukan setelah
user atau pengguna selesai menjawab sepuluh buah soal yang diberikan. Hasil
akumulasi score atau nilai akan ditampilkan dalam bentuk jumlah jawaban
salah dan jumlah jawaban benar. Tampilan halamannya seperti pada gambar
4.21.
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Gambar 4.21 Gambar Tampilan Halaman Tes Tingkat Menengah

4.2.22 Halaman Tes Tingkat Mahir

Halaman ini adalah bagian dari menu tes yang berisi animasi soal tes
untuk tingkat mahir (soal berjumlah sepuluh buah, diambil dari soal — soal
latihan tingkat mahir, dan akan selalu diacak) dan sebuah tombol exit (tombol
yang jika ditekan akan menutup halaman tes tingkat mahir dan kembali ke
menu utama). Proses pemberian score atau nilai dilakukan setelah wuser atau
pengguna selesai menjawab sepuluh buah soal yang diberikan. Hasil
akumulasi score atau nilai akan ditampilkan dalam bentuk jumlah jawaban
salah dan jumlah jawaban benar. Tampilan halamannya seperti pada gambar
422,
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Gambar 4.22 Gambar Tampilan Halaman Tes Tingkat Mahir

4.3 Hasil Pengujian Aplikasi Terhadap Resolusi

Pengujian aplikasi terhadap resolusi pada komputer digunakan untuk
memperoleh hasil tampilan yang sangat cocok dengan aplikasi ini. Dalam ujicoba
ini, resolusi yang diujikan mulai dari ukuran pixel standart yang dimiliki setiap
layar komputer. Gambar 4.23, 4.24, 4.25, 4.26, 4.27, dan 4.28 adalah gambar

pengujian aplikasi dengan berbagai resolusi.
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Gambar 4.23 Gambar Pengujian pada Resolusi 800 x 600
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Gambar 4.25 Gambar Pengujian pada Resolusi 1024 x 768
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Gambar 4.28 Gambar Pengujian pada Resolusi 1280 x 800
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Setelah melakukan pengujian, maka dapat diperoleh hasil data pengujian yang

ditunjukkan dalam tabel 4.3.
Tabel 4.3 Tabel Hasil Pengujian Terhadap Resolusi
No Resolusi Keterangan

1 800 x 600 Tidak Berhasil
2 1024 x 600 Tidak Berhasil
3 1024 x 768 Berhasil

4 1280 x 600 Tidak Berhasil
5 1280 x 768 Tidak Berhasil
6 1280 x 800 Tidak Berhasil

4.4 Hasil Pengujian Aplikasi Terhadap User
Pengujian aplikasi terhadap user digunakan untuk memperoleh hasil data

melalui kuisioner. Setelah mencoba aplikasi, user atau pengguna akan diberikan
lembar kuisioner untuk diisi, dimana kuisioner berisikan 6 (enam) pertanyaan
seputar komentar tentang kelayakan aplikasi pembelajaran aksara Jawa berbasis
multimedia ini. Kuisioner ini diberikan pada:

a) 1 orang guru Bhs. Daerah SLTP

b) 2 siswa SD

¢) 4 orang Mahasiswa

d) 3 orang Pegawai Swasta
Data hasil dari kuisioner ditunjukkan pada tabel 4.4

Tabel 4.4 Tabel Hasil Pengujian Terhadap User

User
No Pertanyaan
1 (2 (3 |4(5(6/|7(|8]|9]10
Apa penilaian anda tentang
adanya Media Pembelajaran
1 | Aksara Jawa Berbasis | 4 | 314 |4 |4la!l3]|4]|4]34
Multimedia bagi pendidikan
ataupun perseorangan ?
2 | Apa penilaian anda mengenai | 2 | 4 |3 |3 (|3!/3|4]|4|3]2
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desain tampilan aplikasi ini ?

Apakah aplikasi ini mudah
dalam penggunaannya ?

Apakah penggunaan aplikasi ini
dapat membantu anda dalam
memahami Aksara Jawa ?

Apakah materi yang
disampaikan  sudah  sesuai
kurikulum yang

sebenarnya ?

dengan

Bagaimanakah peniliaian

aplikasi ini secara keseluruhan ?

Jumlah

18

19

21

20

1820

20

22

19

20

Total Keseluruhan

197

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah (4)

B =Baik / Membantu / Sesuai / Mudah (3)

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah (2)

D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit (1)

Dengan menjumlahkan semua nilai dari kuisioner, dapat diambil range

penilaian terhadap aplikasi sebagai berikut:

Dan total nilai hasil penjumlahan kuisioner sebesar 197 serta terletak di antara
nilai 181 - 240, maka dapat diambil kesimpulan bahwa aplikasi ini sangat
membantu user atau pengguna dalam mempelajari aksara Jawa, mudah dalam
penggunannya, dan materi yang disampaikan sesuai dengan kurikulum yang

0-60

121 - 180 = Baik / Membantu / Sesuai / Mudah
181 - 240 = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah

sebenarnya.

= Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit
61 - 120 = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah




BABYV
PENUTUP

5.1 Kesimpulan
Setelah melakukan perencanaan, pembuatan desain dan pengujian aplikasi,
maka dalam laporan skripsi ini dapat diambil kesimpulan sebagai berikut:

1.

Dalam penerjemahan dari huruf latin ke aksara Jawa sering terjadi
ketidaksesuaian, hal ini disebabkan karena terdapat dua buah pembacaan
dan penulisan aksara Jawa untuk huruf e, yaitu “e” dan ”é”.

Penerjemahan dari huruf latin ke aksara Jawa ataupun sebaliknya dari
aksara Jawa ke huruf latin akan mengalami ketidaksesuaian jika yang
diterjemahkan terdapat huruf ”q” dan ”x”. Hal ini disebabkan karena
aksara Jawa tidak mengenal huruf q” dan ”x”.

Dalam aksara Jawa untuk penulisan awal dari suatu kata harus diawali
dengan aksara carakan dan tidak boleh berupa sandhangan.

Dengan aksara Jawa yang tidak mengenal karakter spasi, maka hasil
penerjemahan dari aksara Jawa ke huruf latin akan sesuai dengan aturan
penulisan yang dimiliki aksara Jawa dan tidak sesuai dengan aturan
penulisan huruf latin.

Berdasarkan hasil pengujian terhadap resolusi, aplikasi ini akan berjalan
dengan baik pada komputer yang memiliki resolusi 1024 x 768 pixel.

Dari hasil pengujian yang dilakukan, penulis berhasil merancang dan
membangun suatu aplikasi pemebalajaran aksara Jawa yang dapat
membantu seseorang lebih mengenal aksara Jawa dan berlatih
menuliskanya dengan mudah, serta mengukur kemampuannya memahami
aksara Jawa melalui soal - soal yang diberikan dengan desain aplikasi yang
menarik

Berdasarkan hasil kuisioner, aplikasi ini sangat membantu user atau
pengguna dalam mempelajari aksara Jawa, mudah dalam penggunannya,
dan materi yang disampaikan sesuai dengan kurikulum yang sebenarnya.
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5.2 Saran
Adapun saran penulis untuk pengembangan aplikasi ini, diantaranya adalah:
1. Menambahkan kamus bahasa Jawa.
2. Menambahkan sebuah kode pada hasil penerjemahan dari aksara Jawa ke
huruf latin agar hasil terjemahannya sesuai dengan aturan penulisan huruf
latin.
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Nama : Oaedatta, 0. Pd
Pekerjaan : CGura OMMP

PENILAIAN

NO PERTANYAAN AlB|C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa \/
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

Apa penilaian anda mengenai desain
tampilan aplikasi ini ? \/

Apakah aplikasi ini mudah dalam \/
penggunaannya ?

Apakah penggunaan aplikasi ini dapat
4 |membantu anda dalam memahami \/
Aksara Jawa ?

Apakah materi yang disampaikan sudah
5 |sesuai dengan kurikulum yang \/

sebenarnya?

Bagaimanakah peniliaian aplikasi ini /
6 secara keseluruhan ?

Catatan : Berilah sebuah tanda centang ( V) pada kolorrl penilaian

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




(X ]

Nama Tatih Torgen
Pekerjaan : % lajor Kelas 5 SD

L]

PENILAIAN

NO
PERTANYAAN AlB|C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa \/
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

Apa penilaian anda mengenai desain

tampilan aplikasi ini ? \/

Apakah aplikasi ini mudah dalam
penggunaannya ?

Apakah penggunaan aplikasi ini dapat
4 |membantu anda dalam memahami J

Aksara Jawa ?

Apakah materi yang disampaikan sudah
5 |sesuai dengan kurikulum  yang \/

sebenarnya?

Bagaimanakah peniliaian aplikasi ini

6 secara keseluruhan ? \/

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama : Davar Pamyyi

Pekerjaan : Pelogar kelos 6 5D

PENILAIAN

NO
PERTANYAAN Al Bl C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa \/

1 Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

Apa penilaian anda mengenai desain \/ /
2 tampilan aplikasi ini ?

Apakah aplikasi ini mudah dalam
3 penggunaannya ? vV

Apakah penggunaan aplikasi ini dapat
4 |membantu anda dalam memahami|  ,

Aksara Jawa ?
Apakah materi yang disampaikan sudah

5 |sesuai dengan kurikulum yang \/
sebenarnya?

Bagaimanakah peniliaian aplikasi ini

Vi

6 secara keseluruhan ?

Catatan : Berilah sebuah tanda centang ( V) pada kolom penilaian

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuvai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama tLUTELAH AN

Pekerjaan : MAHALLSWA

NO

PERTANYAAN

PENILATAN

A

B

C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

v

Apa penilaian anda mengenai desain

tampilan aplikasi ini ?

Apakah aplikasi ini mudah dalam
penggunaannya ?

Apakah penggunaan aplikasi ini dapat
membantu anda dalam memahami
Aksara Jawa ?

Apakah materi yang disampaikan sudah
sesuai dengan kurikulum  yang

sebenarnya?

Vv

6

Bagaimanakah peniliaian aplikasi ini

secara keseluruhan ?

Vv

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:
A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah.

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama

Fian. Aghinkg

Pekerjaan : [“lahao ciswa.

NO

PERTANYAAN

PENILATAN

A

B

C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

v

Apa penilaian anda mengenai desain

tampilan aplikasi ini ?

Apakah aplikasi ini mudah dalam
penggunaannya ?

Apakah penggunaan aplikasi ini dapat
membantu anda dalam memahami
Aksara Jawa ?

Apakah materi yang disampaikan sudah
sesuai dengan kurikulum  yang

sebenarnya?

6

Bagaimanakah peniliaian aplikasi ini

secara keseluruhan ?

v

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah

B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama

Mitr  MMustiko  Rar

LX)

Pekerjaan : Yavsswa

NO

PERTANYAAN

PENILAIAN

A

B

C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

\s

Apa penilaian anda mengenai desain

Aksara Jawa ?

2 tampilan aplikasi ini ? \V
Apakah aplikasi ini mudah dalam

3 penggunaannya ? v
Apakah penggunaan aplikasi ini dapat

4 |membantu anda dalam memahami \/

Apakah materi yang disampaikan sudah
sesuai dengan  kurikulum  yang

sebenarnya?

6

Bagaimanakah peniliaian aplikasi ini

secara keseluruhan ?

V

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:
A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama : Pent . S

Pekerjaan : Mauasiswa

PENILATAN

NO
PERTANYAAN Al Bl C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa ,\/
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

Apa penilaian anda mengenai desain
tampilan aplikasi ini ? v’

Apakah aplikasi ini mudah dalam
penggunaannya ? \/

Apakah penggunaan aplikasi ini dapat
4 |membantu anda dalam memahami \/
Aksara Jawa ?

Apakah materi yang disampaikan sudah
5 |sesuai dengan kurikulum yang \/

sebenarnya?

Bagaimanakah peniliaian aplikasi ini /

6 secara keseluruhan ?

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama : WARDQOYOC
Pekerjaan : (TAF MNMOTARIS - PPAT
PENILAIAN
NO PERTANYAAN
A B|C|D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa \/
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

Apa penilaian anda mengenai desain \/

2 tampilan aplikasi ini ?
Apakah aplikasi ini mudah dalam

3 v/
penggunaannya ?
Apakah penggunaan aplikasi ini dapat

4 |membantu anda dalam memahami \/
Aksara Jawa ?
Apakah materi yang disampaikan sudah

5 |sesuai dengan kurikulum yang \/
sebenarnya?

Bagaimanakah peniliaian aplikasi ini \/

6 secara keseluruhan ?

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama  : Kini JUwAITAH

Pekerjaan :iBu RUMAH TAV6GA

NO

PERTANYAAN

PENILAIAN

A

B

C

D

Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa
Berbasis Multimedia bagi pendidikan

ataupun perseorangan ?

Apa penilaian anda mengenai desain

tampilan aplikasi ini ?

Apakah aplikasi ini mudah dalam
penggunaannya ?

Apakah penggunaan aplikasi ini dapat
membantu anda dalam memahami

Aksara Jawa ?

NSNS

Apakah materi yang disampaikan sudah
sesuai dengan  kurikulum yang

sebenarnya?

6

Bagaimanakah peniliaian aplikasi ini

secara keseluruhan ?

v

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:
A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit




Nama « PANCA AUBAWA

Pekerjaan : swAsTA

PENILAIAN
NO PERTANYAAN AlBlcC D
Apa penilaian anda tentang adanya
Media Pembelajaran Aksara Jawa
1 Berbasis Multimedia bagi pendidikan
ataupun perseorangan ?
Apa penilaian anda mengenai desain
2 | tampilan aplikasi ini ? v’
Apakah aplikasi ini mudah dalam
3 penggunaannya ? v

Apakah penggunaan aplikasi ini dapat
4 |membantu anda dalam memahami o
Aksara Jawa ?

Apakah materi yang disampaikan sudah
5 |sesuai dengan kurikulum  yang v

sebenarnya?

Bagaimanakah peniliaian aplikasi ini \/

6 secara keseluruhan ?

Catatan : Berilah sebuah tanda centang ( V ) pada kolom penilaian

Keterangan:

A = Sangat Baik / Sangat Membantu / Sangat Sesuai / Sangat Mudah
B = Baik / Membantu / Sesuai / Mudah

C = Cukup Baik / Cukup Membantu / Cukup Sesuai / Cukup Mudah
D = Kurang Baik / Kurang Membantu / Kurang Sesuai / Sulit







< Halaman Intro

unit F_Intro;
interface

uses
windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, Stdctrls, OleCtrls, ShockwaveFlashObjects_TLB, Buttons, ExtCtrls, MMSystem,
Menus;

type
TIntro = class(TForm)

Animasi_Intro: TShockwaveFlash;
Menu: TPanel;
PopupMenul: TPopupMenu;
APLIKASIl: TMenultem;
PEMBELAJARANAKSARAJAWAL: TMenultem;
BERBASISMULTIMEDIAl: TMenultem;
WendiAfriantol: TMenultem;
N07125731: TMenultem;
Copyright201120121: TMenultem;
procedure MenuClick(Sender: TObject):
procedure FormCreate(Sender: TObject):

private
{ Private declarations }
public
{ Public declarations }
end;
var

Intro: TIntro;
implementation
uses F_Menu;

{$R *.dfm)

procedure TIntro.MenuClick(Sender: TObject);

begin

Intro.Hide;

Menu_Utama.Show;

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Blank'), 0, SND_ASYNC);
end;

procedure TIntro.FormCreate(Sender: TObject):

begin

With Animasi_Intro do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Intro.swf';
GotoFrame(1);

Play;

end;

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suaral\Intro'), 0, SND_ASYNC):;
end;

end.

< Halaman Menu Utama

unit F_Menu;
interface

uses
Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, ExtCtrls, jpeg, StdCtrls, MMSystem, Menus;

type

TMenu_Utama = class(TForm)
background: TImage;
M _Sejarah: TImage;
CA_Atas: TImage;
CA _Bawah: TImage;
CA: TLabel;
Sejarah: TLabel;
M_Pembelajaran: TImage;
Pembelajaran: TLabel;
P_Atas: TImage;
P_Bawah: TImage;
Aksara_Carakan: TLabel;
Pasangan: TLabel;




sandhangan: TLabel;

Angka_Jawa: TLabel;

Aksara_Swara: TLabel;

Rksara_Rekan: TLabel;

Tanda_Baca: TLabel;

CA_Bawah_Stanby: TImage;

P_Bawah_Stanby: TImage;

M _Konversi: TImage;

Penerjemahan: TLabel;

K_Atas: TImage;

K_Bawah: TImage;

L A: TLabel;

A_L: TLabel;

K_Bawah_Stanby: TImage;

M _Latihan: TImage;

Latihan: TLabel;

L Atas: TImage;

L_Bawah: TImage;

Pemula: TLabel;

Menengah: TLabel;

Mahir: TLabel;

L _Bawah_Stanby: TImage;

M _Tes: TImage;

Tes: TLabel;

Keluar: TImage;

Labell: TLabel;

L _AC: TLabel;

L_P: TLabel;

L_S: TLabel;

: TLabel;

: TLabel;

¢ TLabel;

TLabel;

T Atas. TImage;

T_Bawah TImage;

T_Bawah_Stanby: TImage;

PopupMenul: TPopupMenu;

APLIKASI1l: TMenultem;
PEMBELAJARANAKSARAJAWALl: TMenuItem;
BERBASISMULTIMEDIAl: TMenultem;
WendiAfriantol: TMenultem:

N07125731: TMenultem;

Copyright201120121: TMenuItem;

procedure KeluarClick(Sender: TObject):;
procedure LabellClick(Sender: TObject);
procedure Aksara_CarakanClick(Sender: TObject):
procedure Angka_JawaClick(Sender: TObject):
procedure Aksara SwaraClick(Sender: TObject);
procedure Aksara_RekanClick(Sender: TObject):
procedure PasanganClick(Sender: TObject):;
procedure SandhanganClick(Sender: TObject);
procedure Tanda_BacaClick(Sender: TObject);
procedure CAClick(Sender: TObject);
procedure PemulaClick(Sender: TObject);
procedure MenengahClick(Sender: TObject):;
procedure MahirClick(Sender: TObject);
procedure L AClick(Sender: TObject):
procedure A_LClick(Sender: TObject):
procedure L_ACClick(Sender: TObject):
procedure L_PClick(Sender: TObject):
procedure L _SClick(Sender: TObject):
procedure L AJClick(Sender: TObject);
procedure L AsSClick(Sender: TObject):;
procedure L ARClick(Sender: TObject):
procedure L_TBClick(Sender: TObject);

B

'—J
[+ -]
.

private
{ Private declarations }
public
{ Public declarations }
end;
var

Menu Utama: TMenu_Utama;
implementation

uses F_Aksara_Carakan, F_Angka_Jawa, F_RAksara_Swara, F_Aksara_Rekan,
F Pasangan, F_Sandhangan, F_Tanda Baca, F_Cerita_Ajisaka,
F_ "Latihan _Pemula, F_. Latihan | _Menengah, F Latihan . Mahir, F_Konversi_L_A,
F Konversi AL F Latihan_A;C F;Latlhan_P, ELLatihan_A_J, E_Latihan_A_s,
F_Latihan_A_R, F_Latihan T B, F_Latihan_sS, ShockwaveFlashObjects TLB;




{$R *.dfm)

procedure TMenu_Utama.KeluarClick(Sender: TObject);
begin

Application.Terminate;

end;

procedure TMenu_Utama.LabellClick(Sender: TObject);
begin

Application.Terminate;

end;

procedure TMenu_Utama.Aksara CarakanClick(Sender: TObject):
begin

Form_Rksara_Carakan.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.Angka_JawaClick(Sender: TObject);
begin

Form_Angka_Jawa.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu Utama.Aksara_SwaraClick(Sender: TObject);
begin

Form_Aksara_Swara.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu Utama.Aksara_RekanClick(Sender: TObject);
begin

Form Aksara_ Rekan.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.PasanganClick(Sender: TObject);
begin

Form_Pasangan.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu Utama.SandhanganClick(Sender: TObject):
begin

Form_Sandhangan.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.Tanda_BacaClick(Sender: TObject):
begin

Form Tanda_Baca.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu Utama.CAClick(Sender: TObject);

begin

Form_Cerita_Ajisaka.Show;

Form Cerita_Ajisaka.Animasi_Cerita.Show;

With Form Cerita Ajisaka.Animasi_Cerita do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Cerita Ajisaka\Cerita.swf';
GotoFrame(0);

end;

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Cerita'), 0, SND_ASYNC);
Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.PemulaClick(Sender: TObject):
begin

Form_Tes_Pemula.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.MenengahClick(Sender: TObject);
begin

Form_Tes_Menengah.Show;

Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.MahirClick({Sender: TObject):
begin
Form Tes_Mahir.Show;




Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.L_AClick(Sender: TObject):
begin

Form Konversi_Latin Aksara_dJawa.show;
Form_Konversi_Latin Rksara_Jawa.Latin.Text:='';

Form Konversi_Latin Aksara_ Jawa.Aksara Jawa.Text:='';
Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.A LClick(Sender: TObject);
begin

Form_Konversi Aksara_Jawa_Latin.show;

Form_Konversi Aksara_Jawa_lLatin.Latin.Text:='';
Form_Konversi_ Aksara_dJawa_Latin.Aksara_dJawa.Text:='';
Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.L ACClick(Sender: TObject):
begin

Form_Latihan Aksara_Carakan.Show;
Menu_Utama.Enabled:=False;

end;

procedure TMenu Utama.L PClick(Sender: TObject);
begin

Form Latihan_Pasangan.Show;
Menu_Utama.Enabled:=False;

end;

procedure TMenu Utama.lL SClick(Sender: TObject);
begin

Form_Latihan_Sandhangan.Show;
Menu_Utama.Enabled:=False;

end;

procedure TMenu Utama.L AJClick(Sender: TObject):
begin

Form_Latihan_Angka_Jawa.Show;
Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.L_ASClick(Sender: TObject);
begin

Form Latihan Aksara_Swara.Show:
Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.L ARClick(Sender: TObject):
begin

Form Latihan Aksara_Rekan.Show;
Menu_Utama.Enabled:=False;

end;

procedure TMenu_Utama.L TBClick(Sender: TObject);
begin

Form_Latihan_Tanda_Baca.Show;
Menu_Utama.Enabled:=False;

end;

end.

Halaman Cerita Ajisaka
unit F_Cerita_Ajisaka;
interface

uses
Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, OleCtrls, ShockwaveFlashObjects_ TLB, StdCtrls, ExtCtrls, MMSystem,
Menus;

type

TForm_Cerita_Ajisaka = class(TForm)
Background: TImage;
Cerita_Ajisaka: TLabel;
Animasi_Cerita: TShockwaveFlash;
Exit: TLabel;
PopupMenul: TPopupMenu;
APLIKASIl: TMenultem;
PEMBELAJARANAKSARAJAWALl: TMenultem;
BERBASISMULTIMEDIALl: TMenultem;




La: TLabel;
Pa: TLabel;
Dha: TLabel;
Ja: TLabel;
Ya: TLabel;
Nya: TLabel;
Ma: TLabel;
Ga: TLabel;
Ba: TLabel;

Tha: TLabel;
Nga: TLabel;
Cara_Penulisan:
Contoh: TLabel;
Kalimat: TLabel;
Katal: TLabel;
Exit: TLabel;
Animasi_Ha: TShockwaveFlash;
Animasi_Na: TShockwaveFlash;
Animasi_Ca: TsShockwaveFlash;
Animasi_Ra: TShockwaveFlash;
Animasi_Ka: TShockwaveFlash;
Animasi_Da: TShockwaveFlash;
Animasi_Ta: TShockwaveFlash;
Animasi_sa: TShockwaveFlash;
Animasi_Wa: TShockwaveFlash;
Animasi_La: TShockwaveFlash;
Animasi_Pa: TShockwaveFlash;
Animasi_Dha: TShockwaveFlash
Animasi_dJa: TShockwaveFlash;
Animasi_Ya: TShockwaveFlash:
Animasi_Nya: TShockwaveFlash
Animasi_Ma: TShockwaveFlash;
Animasi_Ga: TShockwaveFlash;
Animasi_Ba: TShockwaveFlash;
Animasi_Tha: TShockwaveFlash;
Animasi_Nga: TShockwaveFlash;

Plus: TLabel;

Kata2: TLabel;

PopupMenul: TPopupMenu;

APLIKASI1: TMenultem;
PEMBELAJARANAKSARAJAWAL: TMenultem;
BERBASISMULTIMEDIAl: TMenultem;
WendiAfriantol: TMenultem;
N07125731: TMenultem;
Copyright201120121: TMenuItem;

TLabel;

~

~e

procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
procedure
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{ Private
public

ExitClick(Sender: TObject);
FormCreate{Sender: TObject);

HaClick(Sender:
NaClick(Sender:
CaClick(Sender:
RaClick(Sender:
KaClick(Sender:
DaClick(Sender:
TaClick({Sender:
saClick(Sender:
WaClick(Sender:
LaClick(Sender:
PaClick(Sender:
DhaClick(Sender
JacClick(sender:
YacClick(Sender:
NyaClick(Sender
MaClick(Sender:
GaClick{Sender:
BaClick(Sender:
ThaClick({Sender
NgaClick(Sender

declarations }

{ Public declarations }

end;

var

Form_Aksara_Carakan:

implementation

uses E‘_Menu;

{SR *.dfm}

procedure TForm Aksara_Carakan.ExitClick(Sender: TObject);

TObject) ;
TObject);
TObject);
TObject) ;
TObject):
TObject):
TObject) ;
TObject);
TObject);
TObject);
TObject);
: TObject):
TObject);
TObject);
: TObject);
TObject);
TObject):
TObject);
: TObject):
: TObject):

TForm_Aksara_Carakan;




begin

Close;
Menu_Utama.Enabled:=True;
Menu_Utama.SetFocus;

end;

procedure TForm Aksara_Carakan.FormCreate(Sender: TObject);
begin
Cara_Penulisan.Hide;
Animasi_Ha.Hide;
Animasi_Na.Hide;
Animasi_Ca.Hide;
Animasi_Ra.Hide;
Animasi_Ka.Hide;
Animasi_Da.Hide;
Animasi_Ta.Hide;
Animasi_sa.Hide;
Animasi_Wa.Hide;
Animasi_La.Hide;
Animasi_Pa.Hide;
Animasi_Dha.Hide;
Animasi_Ja.Hide;
Animasi_Ya.Hide;
Animasi_Nya.Hide;
Animasi_Ma.Hide;
Animasi_Ga.Hide;
Animasi_Ba.Hide;
Animasi_Tha.Hide;
Animasi_Nga.Hide;
Contoh.Hide;
Kalimat.Hide:
Katal.Hide;
Plus.Hide;
Kata2.Hide;

end;

procedure TForm_Aksara Carakan.HaClick(Sender: TObject):
begin

Animasi_Ha.Show;

With Animasi_Ha do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ha.swf';
Visible := True;

GotoFrame(l):

Play;

end;

Cara_Penulisan.Show;

Animasi_Ha.Show:

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Hapa =';

Katal.Caption:='a ';

Kata2.Caption:='p';

Tombol_Contoh_Ha.Show:

PlaySound (PChar (ExtractFilePath{Application.ExeName)+'Suara\Rksara Carakan\Ha'}), O,
SND_ASYNC) ;

end;

procedure TForm Aksara_Carakan.NaClick(Sender: TObject);
begin

Animasi_Na.Show;

With Animasi_Na do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Na.swf';
Visible := True;

GotoFrame (1)

Play;

end;

Cara_Penulisan.Show;

Animasi_Na.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Nadha =';

Katal.Caption:=' n';

Kata2.Caption:='d';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Na'), O,




SND_ASYNC) ;
end;

procedure TForm Aksara_Carakan.CaClick(Sender: TObject):
begin

Animasi_Ca.Show;

With Animasi Ca do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ca.swf';
Visible := True;

GotoFrame (1) ;

Play;

end;

Cara_Penulisan.Show;

Animasi_Ca.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Caja =';

Katal.Caption:='c ';

Kata2.Caption:='q';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Ca'), O,
SND_ASYNC) ;

end;

procedure TForm Aksara_Carakan.RaClick(Sender: TObject):
begin

Animasi Ra.Show;

With Animasi_Ra do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ra.swf';
Visible := True;

GotoFrame(l);

Play;

end;

Cara_Penulisan.Show;

Animasi_Ra.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show:

Kalimat.Caption:='Raya =';

Katal.Caption:='r ';

Kata2.Caption:='y ';;

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Ra'), O,
SND_ASYNC) ;

end;

procedure TForm Aksara_ Carakan.KaClick(Sender: TObject);
begin

Animasi_Ka.Show;

With Animasi_Ka do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Rksara Carakan\Ka.swf';
Visible := True;

GotoFrame(l):

Play;

end;

Cara_Penulisan.Show;

Animasi_Ka.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Kanya =';

Katal.Caption:=' k ';

Kata2.Caption:='v';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Ka'), O,
SND_ASYNC);

end;

procedure TForm_Aksara_Carakan.DaClick(Sender: TObject);

begin

Animasi_Da.Show;

With Animasi_Da do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Da.swf';
Visible := True;




GotoFrame(l);

Play;

end;

Cara_Penulisan.Show;
Animasi_Da.Show;
Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;
Kalimat.Caption:='Dama =';
Katal.Caption:='f ';
Kata2.Caption:='m ';
PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Da'), O,
SND_ASYNC) ;

end;

procedure TForm Aksara Carakan.TaClick(Sender: TObject);
begin

Animasi_Ta.Show;

With Animasi_Ta do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ta.swf';
Visible := True;

GotoFrame(l);

Play;

end;

Cara_Penulisan.Show;

Animasi_Ta.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Taga =';

Katal.Caption:='t ';

Kata2.Caption:='g"';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Ta'), O,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.SaClick(Sender: TObject);
begin

Animasi_Sa.Show;

With Animasi_Sa do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Sa.swf';
Visible := True;

GotoFrame(1);

Play;

end;

Cara_Penulisan.Show;

Animasi_Sa.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Saba =';

Katal.Caption:='s ';

Kata2.Caption:='b ';

Playsound (PChar (ExtractFilePath(Application.ExeName)+'Suaral\Aksara Carakan\sa'), O,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.WaClick(Sender: TObject):
begin

Animasi_Wa.Show;

With Animasi_Wa do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Wa.swf';
Visible := True;

GotoFrame(1);

Play;

end;

Cara_Penulisan.Show;

Animasi Wa.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;




Kalimat.Caption:='Watha =';

Katal.Caption:=' w ';

Kata2.Caption:='q';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Wa'), O,
SND_ASYNC) ;

end;

procedure TForm Aksara_Carakan.LaClick(Sender: TObject):

begin

Animasi_La.Show;

With Animasi_La do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\La.swf';
Visible := True;

GotoFrame(1l);

Play:

end;

Cara_Penulisan.Show;

Animasi_La.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Langa =';

Katal.Caption:='1l ';

Kata2.Caption:='z ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Rksara Carakan\La'), 0O,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.PaClick(Sender: TObject);
begin

Animasi_Pa.Show;

With Animasi_Pa do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Rksara Carakan\Pa.swf';
Visible := True;

GotoFrame(l);

Play;

end;

Cara_Penulisan.Show;

Animasi_Pa.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Paha =';

Katal.Caption:='p';

Kata2.Caption:='a ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Pa'), O,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.DhaClick(Sender: TObject):
begin

Animasi_bha.Show;

With Animasi_Dha do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Dha.swf';
Visible := True;

GotoFrame(l);

Play:;

end;

Cara_Penulisan.Show;

Animasi_Dha.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Dhana =';

Katal.Caption:=' d';

Kata2.Caption:='n ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Dha'), O,
SND_ASYNC)

end;

procedure TForm_Aksara_Carakan.JaClick(Sender: TObject);
begin

Animasi_ Ja.Show;

With Animasi_Ja do

begin




Movie := ExtractFilePath(Application.ExeName)+'Animasi\Bksara Carakan\Ja.swf';
Visible := True;

GotoFrame(1);

Play;

end;

Cara_Penulisan.Show;

Animasi_Ja.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Jaca =';

Katal.Caption:='j"';

Kata2.Caption:='c ';

PlaySound {(PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Ja'), O,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.YaClick(Sender: TObject);
begin

Animasi_Ya.Show;

With Animasi_Ya do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ya.swf';
Visible := True;

GotoFrame (1) ;

Play:;

end;

Cara_Penulisan.Show;

Animasi_Ya.Show;

Contoh. Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Yara =';

Katal.Caption:='y ';

Kata2.Caption:='r ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suaral\Pksara Carakan\Ya'), O,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.NyaClick(Sender: TObject);
begin

Animasi_Nya.Show;

With Animasi_Nya do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Nya.swf';
Visible := True;

GotoFrame(l);

Play;

end;

Cara_Penulisan.Show;

Animasi_Nya.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Nyaka =';

Katal.Caption:=' v ';

Kata2.Caption:='k ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Rksara Carakan\Nya'), O,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.MaClick(Sender: TObject):
begin

Animasi_Ma.Show;

With Animasi Ma do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ma.swf';
Visible := True;

GotoFrame(l);

Play:;

end;

Cara_Penulisan.Show;
Animasi_Ma.Show;
Contoh.Show;
Kalimat.Show;
Katal.Show;




Plus.Show;

Kata2.Show;

Kalimat.Caption:='Mada =';

Katal.Caption:=' m ';

Kata2.Caption:='f"';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suaral\Aksara Carakan\Ma'), 0,
SND_ASYNC) ;

end;

procedure TForm_Aksara_Carakan.GaClick(Sender: TObject):
begin

Animasi_Ga.Show;

With Animasi_Ga do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ga.swf';
Visible := True;

GotoFrame(l);

Play:

end;

Cara_Penulisan.Show;

Animasi_Ga.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Gata =';

Katal.Caption:='g';

Kata2.Caption:='t ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suaral\Aksara Carakan\Ga'), 0,
SND_ASYNC) ;

end;

procedure TForm Aksara_Carakan.BaClick(Sender: TObject):;
begin

Animasi_Ba.Show;

With Animasi_Ba do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Ba.swf';
Visible := True;

GotoFrame(l);

Play;

end;

Cara_Penulisan.Show;

Animasi_Ba.Show;

Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show:

Kalimat.Caption:='Basa =';

Katal.Caption:='b ';

Kata2.Caption:='s ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Ba'), O,
SND_ASYNC)

end;

procedure TForm_Aksara_Carakan.ThaClick(Sender: TObject);
begin

Animasi Tha.Show;

With Animasi_Tha do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasi\Aksara Carakan\Tha.swf';
Visible := True;

GotoFrame(1l);

Play;

end;

Cara_Penulisan.Show;

Animasi_Tha.Show;

Contoh.Show:

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;

Kalimat.Caption:='Thawa =';

Katal.Caption:=' q';

Kata2.Caption:='w ';

PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Rksara Carakan\Tha'), O,
SND_ASYNC) ;

end;

procedure TForm Aksara Carakan.NgaClick(Sender: TObject);
begin
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Animasi_Nga.Show;

With Animasi_ Nga do

begin

Movie := ExtractFilePath(Application.ExeName)+'Animasil\Aksara Carakan\Nga.swf';
Visible := True;
GotoFrame(l);

Play; end;
Cara_Penulisan.Show;
Animasi_Nga.Show;
Contoh.Show;

Kalimat.Show;

Katal.Show;

Plus.Show;

Kata2.Show;
Kalimat.Caption:='Ngala =';
Katal.Caption:='z ';
Kata2.Caption:='l *;
PlaySound (PChar (ExtractFilePath(Application.ExeName)+'Suara\Aksara Carakan\Nga'), O,
SND_ASYNC) ;

end;

end.

Halaman Penerjemah Latin — Aksara Jawa

unit F_Konversi_ L _A;
interface

uses
Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, ExtCtrls, StdCtrls, Buttons, Menus;

type
TForm_Konversi_Latin_Aksara_Jawa = class(TForm)

Background: TImage;

Exit: TLabel;

Konversi: TLabel;

Aksara_Jawa: TMemo;

Tombol_e: TPanel;

Kosongkan: TPanel;

Hasil: TMemo;

Terjemahkan: TPanel;

Latin: TMemo;

Tulis: TMemo;

PopupMenul: TPopupMenu;

APLIKASIl: TMenultem;

PEMBELAJARANAKSARAJAWAL: TMenultem;

BERBASISMULTIMEDIALl: TMenultem;

WendiAfriantol: TMenultem;

N07125731: TMenultem;

Copyright201120121: TMenultem;

procedure i;

procedure u

procedure e

procedure o;

procedure ee;

procedure angka;

procedure ExitClick(Sender: TObject);

procedure ExitMouseMove(Sender: TObject; Shift: TshiftState; X,
Y: Integer);

procedure BackgroundMouseMove (Sender: TObject; Shift: TshiftState; X,
Y: Integer);

procedure Tombol_eClick(Sender: TObject);

procedure KosongkanClick(Sender: TObject):

procedure TerjemahkanClick(Sender: TObject);

procedure LatinChange (Sender: TObject);

procedure TulisKeyPress(Sender: TObject; var Key: Char):;

YR YRR

private
{ Private declarations }
public
{ Public declarations }
end;
var

Form_Konversi_Latin_Aksara_Jawa: TForm Konversi_Latin_Aksara_Jawa;
hl,h2,h3 :string;
index_huruf, index_latin, index_aksara :string;
angka:string;
flag_2,flag_3,flag : boolean;
flag_o, flag_rekan :boolean;
panjang : integer;
implementation




uses F_Menu;
{$R *.dfm}

procedure TForm_Konversi_Latin_Aksara_Jawa.ExitClick(Sender: TObject);
begin

Menu_Utama.Enabled:=True;

Menu_Utama.SetFocus;

end;

procedure TForm Konversi_Latin Aksara_Jawa.i;

begin

Rksara_Jawa.Text:= copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'i';
end;

procedure TForm Konversi_ Latin Aksara Jawa.u;
begin

if (flag=true) and (hl='r') and (index_latin<>'=')and (flag_ 2=true)then

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-1)+'('; flag_o:=True;
flag_rekan:=True;

end else

Aksara_Jawa.Text:= copy(Aksara_dJawa.Text,0,length(Aksara_Jawa.Text))+'u';

end;

procedure TForm Konversi_Latin Aksara_dJawa.e;
begin

if (flag=true) and (hl='r') and (index_latin<>'=')and (flag_ 2=true)then

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text)-1)+'}"'; flag_o:=True;
flag_rekan:=True;

end else

Aksara_Jawa.Text:= copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'e';
end;

procedure TForm Konversi_Latin Aksara_Jawa.o;
begin

if flag_o=false then

Aksara_dJawa.Text:=copy (Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-
1)+'['+copy(Rksara_Jawa.Text,length(Aksara_Jawa.Text),2)+'o' else
Aksara_Jawa.Text:=copy (Aksara_Jawa.Text,0,length(Aksara_Jgawa.Text)-
2)+'['+copy(Aksara_Jawa.Text,length(Aksara_Jawa.Text)-1,2)+'o';

end;

procedure TForm Konversi_Latin_ Aksara_Jawa.ee;

begin

if flag_rekan=false then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jdawa.Text)-
1)+'['+copy(Rksara_Jawa.Text,length(Aksara_ Jawa.Text),2) else
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-
3)+' ['+copy (Aksara_Jawa.Text, length(Aksara_Jawa.Text)-3,3); end;
procedure TForm_Konversi Latin Aksara_dJawa.angka;
begin

if Length(Latin.Text)<2 then

hl:='a' else

hl:=copy(Latin.Text, length(Latin.Text)-1,1);

if (h1<>'1') and (hl<>'2') and (h1<>'3') and (h1<>'4') and (hl<>'5')and (hl<>'6')
and(hl<>'7') and
(hl<>'8') and (hl<>'9') and (h1<>'0') then

begin

if (index_huruf='1') then

Aksara_Jawa.Text:=copy (Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+';1l;' else
if (index_huruf='2') then
Rksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Rksara_vJawa.Text))+';2;' else
if (index_huruf='3') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+';3:;' else
if (index_huruf='4') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+';4;' else
if (index_huruf='5') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+';5;' else
if (index_huruf='6') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara Jawa.Text))+';6;' else
if (index_huruf='7') then
Rksara_dJawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+';7;' else
if (index_huruf='8') then
Rksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara Jawa.Text))+';8;' else
if (index_huruf='9') then

Aksara Jawa.Text:=copy(Rksara_dJawa.Text,0,length(Aksara_Jawa.Text))+';9;' else
if (index_huruf='0') then
Aksara_Jawa.Text:=copy(Aksara_dJawa.Text,0,length(RAksara_Jawa.Text)}+';0;' else




end else

begin

if (index_huruf='1') then Aksara_Jawa.Text:=copy(Aksara_UJawa.Text,0,length(Aksara_Jawa.Text)-
1)+'1;' else

if (index_huruf='2') then Aksara_ Jawa.Text:=copy(Aksara_dJawa.Text,0,length(Aksara_Jawa.Text)-
1)+'2;' else

if (index_huruf='3') then Aksara_Jawa.Text:=copy(Aksara_Jdawa.Text, 0, length(Aksara_Jawa.Text)-
1)+'3;"' else

if (index_huruf='4') then Rksara_Jawa.Text:=copy(Rksara_Jawa.Text,0,length(Rksara_Jawa.Text)-
1)+'4;' else

if (index_huruf='5') then Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-
1)+'5;' else

if (index_huruf='6') then RAksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-
1)+'6;"' else

if (index_huruf='7') then Rksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-
1)+'7; else

if (index_huruf='8') then Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0, length(Aksara_Jawa.Text)-
1)+'8;' else

if (index_huruf='9') then Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text)-
1)+'9;"' else

if (index_huruf='0') then Aksara_Jawa.Text:=copy(Aksara_ Jawa.Text,0,length(Aksara_Jawa.Text)-
1)+'0;"' else

end;

end;

procedure TForm Konversi_Latin Aksara_dJawa.Tombol_eClick({Sender: TObject):;
begin

Tulis.Text:=Tulis.Text+'é’';

end;

procedure TForm_Konversi_Latin_Aksara_Jawa.KosongkanClick(Sender: TObject);

begin
Latin.Text:='"';
Tulis.SetFocus;

Tulis.Text:='"';
Hasil.Text:='"';
Aksara Jawa.Text:='';
flag :=false;
flag_2:=false;
flag_3:=false;
flag_o:=false;
flag_rekan:=false;
Tulis.ReadOnly:=false;
end;

procedure TForm_Konversi_Latin Aksara_Jawa.TerjemahkanClick(Sender: TObject):
var
p:Integer;
begin
Aksara Jawa.Lines.Clear;
Latin.Lines.Clear;
for p:=1 to length(Tulis.Text) do
begin
hl:=Copy(Tulis.Text,p,1):
if hl<>' ' then
Latin.Text:=Latin.Text+LowerCase(hl);
end;
Hasil.Text:=Aksara Jawa.Text;
Kosongkan.SetFocus;
end;

procedure TForm_Konversi_Latin_ Aksara_Jawa.LatinChange(Sender: TObject);
begin

flag :=false;

flag_2:=false;

flag_3:=false;

flag_o:=false;

flag_rekan:=false;

index_huruf:=copy(Latin.Text,length(Latin.text),1);
index_latin:=copy (Aksara_ Jawa.Text,length(Aksara_Jawa.text)-2,1);
index_aksara:=copy (Aksara_Jdawa.Text, length(Aksara_Jawa.text)-1,1);
hl:=copy(Latin.Text, length(Latin.Text)-1,1);

if Length(Latin.Text)>2 then

h2:=copy(Latin.Text, length(Latin.Text)-2,1) else h2:='a’';

if Length(Latin.Text)>3 then
h3:=copy(Latin.Text,length(Latin.Text)-3,1) else h3:='a';

if (index_huruf='a') or (index_huruf='i')

or (index_ huruf='u') or (index_huruf='e')

or (index_huruf='o') or (index_huruf='é') then
flag:=true;




if (h2<>'a') and (h2<>'i') and (h2<>'u') and (h2<>'e') and (h2<>'o') and (h2<>'é') and
(h2<>'r') and (h2<>'h') and
(index_aksara<>';') and (index_latin<>';') and(h2<>'A') and (h2<>'I') and (h2<>'U') and
(h2<>'E') and (h2<>'0'} then
flag_2:=true else flag_2:=false;
if (h3<>'a') and (h3<>'i') and (h3<>'u') and (h3<>'e') and (h3<>'o')and (h3<>'é') and
(h3<>'r') and
{index_aksara<>';') and (index_latin<>';') and (h2<>'A') and (h2<>'I') and (h2<>'U') and
(h2<>'E') and (h2<>'0')then
flag_3:=true else flag_3:=false;

if (flag=true) and (hl='h') and (index_aksara<>'=') and (flag_2=true) and
(h2<>'d') and (h2<>'t') and (h2<>'g') and (h2<>'k')

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-2)+'H';
flag_o:=True; flag_ rekan:=True;

end else

if (flag=true) and (hl='n') and (index_latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Rksara Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'N';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='c') and (index latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara Jawa.Text)-3)+'C';
flag_o:=True; flag_rekan:=True;

end else
if (flag=true) and (hl='r') and (index_latin<>'=')and (flag_2=true)

then begin RAksara Jawa.Text:=copy(Aksara_dJawa.Text,0,length(Aksara_Jawa.Text)-2)+']';
flag_o:=True; flag_rekan:=True;

end else
if (flag=true) and (hl='k') and (index latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Rksara_Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'K';
flag_o:=True; flag_rekan:=True;

end else
if (flag=true) and (hl='d') and (index_latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jdawa.Text)-3)+'F';
flag_o:=True; flag_rekan:=True;

end else
if (flag=true) and (hl='t') and (index_latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'T';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='s') and (index_latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jdawa.Text)-3)+'S';
flag o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='w') and (index_latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'W';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='l') and (index latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length{Aksara_Jawa.Text)-3)+'L';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='p') and (index_latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy{Aksara Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'P';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='j') and (index_latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jdawa.Text)-3)+'J';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='y') and (index_latin<>'=')and (flag_2=true) and (h2<>'n')

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'-';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='m') and {(index_latin<>'='}and (flag 2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'M';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='g') and (index_ latin<>'=')and (flag_2=true) and (h2<>'n')

then begin Aksara_Jawa.Text:=copy(Rksara_Jawa.Text, 0, length(Aksara_Jawa.Text)-3)+'G';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='b') and (index latin<>'=')and (flag_2=true)

then begin Aksara_Jawa.Text:=copy(Aksara_dJawa.Text,0,length(Aksara_Jawa.Text)-3)+'B';
flag_o:=True; flag rekan:=True;

end else

if (flag=true) and (hl='h') and (h2='d') and (index_latin<>'=')and (flag_3=true)

then begin Aksara_dJawa.Text:=copy(Rksara_dJdawa.Text,0,length(Aksara_Jawa.Text)-4)+'D';
flag o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='y') and (h2='n') and (index_latin<>'=')and (flag_3=true)

then begin Aksara_dJawa.Text:=copy (Rksara_Jdawa.Text,0,length(Aksara_Jawa.Text)-5)+'V';




flag_o:=True; flag_rekan:=True;

end else
if (flag=true) and (hl='h') and (h2='t') and (index_latin<>'=')and (flag_3=true)

then begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-4)+'Q';
flag_o:=True; flag_rekan:=True;

end else
if (flag=true) and (hl='g'} and (h2='n') and (index_latin<>'=') and (flag_3=true)

then begin Aksara_Jawa.Text:=copy(Aksara_dJawa.Text, 0, length(Aksara_Jawa.Text)-2)+'2';
flag_o:=True; flag_rekan:=True;

end else

if (flag=true) and (hl='h') and (h2='k') then

begin Aksara_dJdawa.Text:=copy(Rksara_Jawa.Text, 0, length(Aksara_Jawa.Text)-3)+'k+';
flag_rekan:=true; end else

if (flag=true) and (hl='z') and (h2='d') then

begin Aksara_Jawa.Text:=copy(Rksara_Jawa.Text,0,length(Aksara_Jawa.Text)-5)+'f+';
flag_rekan:=true; end else

if (flag=true) and (hl='h') and (h2='g') then

begin Aksara Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'g+';
flag_rekan:=true; end else

if (flag=true) and (hl='£') and (hl='v') then

begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'p+':
flag_rekan:=true; end else

if (flag=true) and (hl='z') then

begin Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'j+"';
flag_rekan:=true; end else

if (flag=true) and (hl='h') and (h2='d') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-3)+'d' else
if (flag=true) and (hl='y') and (h2='n') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-4)+'v' else
if (flag=true) and (hl='h') and (h2='t') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0, length(Aksara_Jawa.Text)-3)+'q' else
if (flag=true) and (hl='g') and (h2='n') then
Aksara_Jawa.Text:=copy(Aksara_oJawa.Text,0,length(Aksara_Jawa.Text)-1)+'z' else
if (flag=true) and (hl='h') and (h2<>'d') then
Rksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-1l)+'a' else
if (index_huruf='n') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,1ength(Aksara_Jawa.Text))+'n\‘ else
if (index_huruf='c') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)}+'c\' else
if (index_huruf='k'} then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'k\' else
if (index_huruf='d') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'f\' else
if (index_huruf='t') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'t\' else
if (index_huruf='s') then
Aksara_Jdawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_dJawa.Text))+'s\' else
if (index_huruf='w') then
Aksara_Jawa.Text:=copy (Aksara_Jawa.Text, 0, length (Aksara_Jawa.Text))+'w\' else
if (index_huruf='l') then

Aksara_Jawa.Text:=copy (Aksara_Jawa.Text,0, length(Aksara_Jawa.Text))+'1\’' else
if (index_huruf='p') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'p\' else
if (index_huruf='j') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'j\' else
if (index_huruf='y') then

Aksara_Jawa.Text:=copy (Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))}+'y\' else
if (index_huruf='m') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'m\' else
if (index_huruf='g') and (hl<>'n') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0, length(Aksara_Jawa.Text))+'g\' else
if (index_huruf='b') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'b\' else

if (flag=true) and (hl='r') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)-1)+'r’' else

if (flag=true) and (hl<>'a') and(hl<>'i') and(hi<>'u') and(hl<>'e') and(hl<>'o') and
(h1<>'0') and (hl<>'1') and (hl1<>'2') and (h1<>'3') and (hl<>'4') and (hl<>'5') and
(h1<>'6') and (h1<>'7') and (hl1<>'8'} and (hl<>'9')
then Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text)-1) else
if (flag=true) and
({hls'a') or (hl='i') or (hl='u') or (hl='e'} or (hl='o') or (hl='é') or
(h1='0') or (hl='l') or (hl='2') or (hl='3') or (hl='4"') or
(h1='5"') or (hl='6') or (hl='7') or (hl='8') or (hl='9'))
then Rksara_dJawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'a' else
if (index_huruf='r') then
Rksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'/' else
if (index_huruf='h') then
Aksara_Jdawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara Jawa.Text))+'h' else




if (index_huruf='g') and (hl='n') then
Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0,length(Aksara_Jawa.Text)-2)+'=';

if index_huruf='A' then
Aksara_. Jawa. Text :=copy (Aksara_Jawa.Text, 0, length (Aksara_Jawa. Text))+'A' else
if index _huruf='I' then
Aksara_ Jawa. Text:=copy (Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'I' else
if index huruf='U' then
Aksara_. Jawa. Text:=copy (Rksara_Jawa.Text,0,length(Aksara_Jawa. Text))+'U' else
if lndex huruf='E' then
Aksara_. Jawa. Text:=copy (Rksara_Jawa.Text,0,length(Aksara_Jawa. Text))+'E' else
if 1ndex huruf='0' then
Aksara_ Jawa. Text:=copy (Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'0' else

if index huruf='.' then

Aksara_ Jawa. Text:=copy (Aksara_Jawa.Text, 0, length{Aksara_Jawa. Text))+'.' else
if index huruf=',' then
Aksara_. Jawa. Text:=copy (Aksara_Jawa.Text, 0, length (Aksara_Jawa.Text))+', else

if (index_huruf='i') then i;

if (index_huruf='u') then u;

if (index_huruf='e') then e;

if (index_huruf='o') then o;

if (index_huruf='é') then ee;

if (index_huruf='1') or {(index huruf='2') or (index_ huruf='3') or (index huruf='4') or
(index_huruf='5') or (index_huruf='6') or (index huruf='7') or (index huruf='8') or
{index_huruf='9') or (index_huruf='0') then angka;

{ if (index_huruf<>'a') and (index_huruf<>'i') and (index_huruf<>'u') and (index huruf<>'e')
and (index_huruf<>'o') and (index_huruf<>'é') then

Aksara_Jawa.Text:=copy (Aksara_Jawa.Text,length(Aksara_Jawa. Text),1) +
copy(Aksara Jawa.Text, length(Aksara_Jawa.Text)-1,1) else; }

end;

procedure TForm_Konversi_Latin Aksara_Jawa.TulisKeyPress(Sender: TObject;
var Key: Char);
begin
if (key in(#88,#120,#81,#113])) then
begin
if MessageDlg ('Huruf yang anda masukkan salah, karena Aksara Jawa tidak mengenal huruf Q
dan X', mtInformation, [mbOK],0)} = mrOK
then
begin
key:=#0;
end
else;
end;
end;
end.

Halaman Penerjemah Aksara Jawa — Latin

unit F_Konversi_ A _L;
interface

uses
Windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, ExtCtrls, StdCtrls, ComCtrls, Buttons, Menus;

type
TForm_Konversi_Aksara_Jawa_Latin = class(TForm)

Latin: TMemo;
Kosongkan: TPanel;
Konversi: TLabel;
Exit: TLabel;
Background: TImage;
Aksara_Jawa: TMemo;
Huruf: TPageControl;
Aksara_Carakan: TTabSheet;
Pasangan: TTabSheet;
Aksara_Swara: TTabSheet;
Aksara_Rekan: TTabsheet;
Wilangan: TTabSheet;
Sandhangan: TTabSheet;
Terjemahkan: TPanel;
Aksara Carakan_Tombol_ Ha: TSpeedButton;
Aksara_Carakan Tombol Na: TSpeedButton;
Aksara_ Carakan Tombol_Ca: TSpeedButton;
Aksara_Carakan Tombol Ra: TSpeedButton;
Aksara_Carakan_Tombol Ka: TSpeedButton;
Rksara_Carakan Tombol Pa: TSpeedButton;




Aksara_Carakan_Tombol Dha: TSpeedButton;
Aksara_Carakan_Tombol_Ja: TSpeedButton;
Aksara_Carakan_Tombol_Ya: TSpeedButton;
Aksara_Carakan_Tombol_Nya: TSpeedButton;
Aksara_Carakan_Tombol Da: TSpeedButton;
Aksara_Carakan_Tombol Ta: TSpeedButton;
Aksara_Carakan_Tombol Sa: TSpeedButton;
Aksara_Carakan_Tombol_Wa: TSpeedButton;
Aksara_Carakan_Tombol La: TSpeedButton;
Rksara_Carakan_Tombol Ma: TSpeedButton;
Aksara_Carakan Tombol_Ga: TSpeedButton;
Rksara_Carakan_Tombol_Ba: TSpeedButton;
Rksara_Carakan_Tombol_ Tha: TSpeedButton;
Rksara_Carakan Tombol Nga: TSpeedButton:
Pasangan_Tombol Ha: TSpeedButton;
Pasangan_Tombol Na: TSpeedButton;
Pasangan_Tombol_Ca: TSpeedButton;
Pasangan_Tombol_Ra: TSpeedButton;
Pasangan_Tombol_Ka: TSpeedButton;
Pasangan_Tombol_Da: TSpeedButton;
Pasangan_Tombol_Ta: TSpeedButton;
Pasangan_Tombol_Sa: TSpeedButton;
Pasangan_Tombol_Wa: TSpeedButton;
Pasangan_Tombol_La: TSpeedButton;
Pasangan_Tombol_Pa: TSpeedButton;
Pasangan_Tombol_Dha: TSpeedButton:
Pasangan Tombol_Ja: TSpeedButton;
Pasangan_Tombol_Ya: TSpeedButton;
Pasangan_Tombol_Nya: TSpeedButton;
Pasangan_Tombol_ Ma: TSpeedButton;
Pasangan_Tombol_Ga: TSpeedButton;
Pasangan_Tombol_Ba: TSpeedButton:
Pasangan_Tombol_Tha: TSpeedButton;
Pasangan_Tombol_Nga: TSpeedButton;
Rksara_Swara_Tombol A: TSpeedButton;
Rksara_Swara_Tombol_I: TSpeedButton;
Aksara_Swara_Tombol U: TSpeedButton;
Aksara_swara_Tombol_E: TSpeedButton;
Rksara_swara_Tombol_O: TSpeedButton;
Aksara_Rekan Tombol Kha: TSpeedButton;
Aksara_Rekan_Tombol_Va: TSpeedButton;
Aksara_Rekan_Tombol_Dza: TSpeedButton;
Aksara_Rekan Tombol Gha: TSpeedButton;
Aksara_Rekan_Tombol_2Za: TSpeedButton;

Wilangan_Tombol_l: TSpeedButton;
Wilangan Tombol 2: TSpeedButton;
Wilangan_Tombol_3: TSpeedButton;
Wilangan_Tombol_4: TSpeedButton;
Wilangan_Tombol_5: TSpeedButton;
Wilangan_Tombol_6: TSpeedButton;
Wilangan_Tombol_7: TSpeedButton;
Wilangan_Tombol_ 8: TSpeedButton;
Wilangan_Tombol_ 9: TSpeedButton;
Wilangan_Tombol_0: TSpeedButton;

Wilangan_Tombol_Tanda: TSpeedButton;

Sandhangan_Tombol_i: TSpeedButton;

Sandhangan_Tombol h: TSpeedButton;

Sandhangan_Tombol_u: TSpeedButton;

sandhangan_Tombol ng: TSpeedButton;

Sandhangan_Tombol_e: TSpeedButton;
Sandhangan_Tombol_awalan: TSpeedButton;
Sandhangan_Tombol_ee: TSpeedButton;
Sandhangan_Tombol_titik: TSpeedButton;
Sandhangan_Tombol_o: TSpeedButton;

Sandhangan Tombol_koma: TSpeedButton;
Sandhangan_Tombol_r: TSpeedButton;
Sandhangan_Tombol_pangkon: TSpeedButton;

PopupMenul: TPopupMenu;

APLIKASI1: TMenultem;

PEMBELAJARANAKSARAJAWAL: TMenultem;

BERBASISMULTIMEDIAl: TMenultem;

WendiAfriantol: TMenultem;

N07125731: TMenultem;

Copyright201120121: TMenultem;

procedure ExitClick(Sender: TObject):

procedure Rksara_Carakan_Tombol_ HaClick(Sender: TObject);
procedure Aksara_Carakan_Tombol NaClick(Sender: TObject):
procedure Aksara_Carakan_Tombol_CaClick(Sender: TObject);
procedure Aksara_Carakan_Tombol RaClick(Sender: TObject):;
procedure Aksara_Carakan_Tombol KaClick(Sender: TObject);
procedure Aksara_Carakan_Tombol DaClick(Sender: TObject);
procedure Aksara_Carakan_Tombol TaClick(Sender: TObject):




procedure Aksara_Carakan_Tombol_ SaClick(Sender: TObject);
procedure Aksara_Carakan Tombol WaClick(Sender: TObject):;
procedure Aksara_Carakan Tombol LaClick(Sender: TObject);
procedure Rksara_Carakan_Tombol_PaClick(Sender: TObject);
procedure Aksara_Carakan_Tombol DhaClick(Sender: TObject);
procedure Aksara Carakan ' _Tombol, JaCllck(Sender° TObject)
procedure Aksara_( Carakan Tombol YaCllck(Sender° TObject);
procedure Aksara_Carakan_Tombol_NyaClick(Sender TObject);
procedure Rksara_Carakan_ Tombol MaClick(Sender: TObject);
procedure Aksara_Carakan_Tombol_GaClick(Sender: TObject):
procedure Aksara_Carakan_Tombol BaClick(Sender: TObject):
procedure Aksara_Carakan Tombol_ThaClick(Sender: TObject);
procedure Aksara_Carakan_Tombol NgaClick(Sender: TObject):
procedure KosongkanClick(Sender: TObject):;
procedure TerjemahkanClick(Sender: TObject):
procedure FormCreate(Sender: TObject):
procedure Pasangan_Tombol HaClick(Sender: TObject):
procedure Pasangan_Tombol_NaClick(Sender: TObject):
procedure Pasangan_Tombol CaClick(Sender: TObject):
procedure Pasangan_Tombol_RaClick(Sender: TObject):;
procedure Pasangan_Tombol_ KaClick(Sender: TObject);
procedure Pasangan_Tombol_DaClick(Sender: TObject);
procedure Pasangan_Tombol TaClick(Sender: TObject);
procedure Pasangan_ Tombol _SaClick(Sender: TObject):
procedure Pasangan_ Tombol _WaClick(Sender: TObject):
procedure Pasangan_Tombol_LaClick(Sender: TObject):
procedure Pasangan Tombol PaClick(Sender: TObject);
procedure Pasangan_Tombol_ DhaClick(Sender: TObject);
procedure Pasangan_Tombol JaClick(Sender: TObject);
procedure Pasangan_Tombol YaClick(Sender: TObject):
procedure Pasangan_Tombol NyaClick(Sender: TObject);
procedure Pasangan Tombol MaClick(Sender: TObject):;
procedure Pasangan Tombol GaClick(Sender: TObject):
procedure Pasangan_Tombol BaClick(Sender: TObject);
procedure Pasangan Tombol ThaClick(Sender: TObject);
procedure Pasangan_Tombol NgaClick(Sender: TObject);
procedure Rksara_Swara_Tombol AClick({Sender: TObject);
procedure Aksara_Swara_Tombol IClick(Sender: TObject);
procedure Aksara_Swara_Tombol UClick(Sender: TObject):
procedure Aksara_Swara Tombol EClick(Sender: TObject):
procedure Aksara_Swara_Tombol OClick(Sender: TObject):
procedure Aksara_Rekan_Tombol KhaClick(Sender: TObject);
procedure Rksara_Rekan Tombol VaClick(Sender: TObject);
procedure Rksara_Rekan Tombol_DzaClick(Sender: TObject);
procedure Aksara_Rekan_Tombol GhaClick(Sender: TObject):;
procedure Aksara_Rekan_Tombol 2ZaClick(Sender: TObject);
procedure Wilangan_Tombol_lClick(Sender: TObject);
procedure Wilangan_Tombol_2Click(Sender: TObject);
procedure Wilangan Tombol_3Click(Sender: TObject);
procedure Wilangan_Tombol_ 4Click(Sender: TObject):
procedure Wilangan_ Tombol_ 5Click({Sender: TObject):
procedure Wilangan_Tombol_6Click(Sender: TObject);
procedure Wilangan ' Tombol _7Click(Sender: TObject);
procedure Wllangan_Tombol_Scllck(Sender' TObject);
procedure Wilangan Tombol 9Click(Sender: TObject):
procedure Wilangan_Tombol OClick(Sender: TObject);
procedure Wilangan_ Tombol Tandacllck(Sender' TObject);
procedure Sandhangan_' Tombol _iClick(Sender: TObject);
procedure Sandhangan_Tombol_uClick(Sender‘ TObject);
procedure Sandhangan_Tombol_eClick{(Sender: TObject):;
procedure Sandhangan_Tombol_ rClick(Sender: TObject);
procedure Sandhangan_Tombol hclick(Sender. TObject);
procedure Sandhangan_ Tombol ngcllck(Sender- TObject);
procedure Sandhangan Tombol awalanClick(Sender: TObject):
procedure Sandhangan_Tombol_ titikClick(Sender: TObject):
procedure Sandhangan Tombol | _komaClick(Sender: TObject);
procedure Sandhangan Tombol_pangkonCllck(Sender. TObject);

private
{ Private declarations }

public
{ Public declarations }

end;

var
Form Konversi_Aksara_Jawa_Latin: TForm Konversi_Aksara_Jawa_latin;

implementation
uses F_Menu;

{SR *.dfm}




procedure TForm Konversi_Aksara_Jawa_Latin.ExitClick(Sender: TObject);
begin

Menu_Utama.Enabled:=True;

Menu_Utama.SetFocus;

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Aksara_ Carakan_Tombol HaClick(
Sender: TObject);

begin

Rksara_Jawa.Text:=Aksara_ Jawa.Text+'a';

Memol.Text:=Memol.Text+'ha';

end;

procedure TForm_Konversi_Aksara_Jdawa_Latin.Rksara_Carakan_Tombol_NaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=Aksara_Jawa.Text+'n';

Memol.Text:=Memol.Text+'na’';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Aksara_Carakan_Tombol_CaClick(
Sender: TObject):

begin

Rksara_Jawa.Text:=Aksara_Jawa.Text+'c';

Memol.Text:=Memol.Text+'ca';

end;

procedure TForm Konversi_Aksara_Jawa_Latin.Aksara_Carakan_Tombol_RaClick(
Sender: TObject);

begin

Rksara_Jawa.Text:=Rksara_Jawa.Text+'r';

Memol.Text:=Memol.Text+'ra';

end;

procedure TForm Konversi_ Aksara_Jawa_Latin.Rksara_Carakan_Tombol KaClick(
Sender: TObject);

begin

Aksara_dJawa.Text:=Aksara_Jawa.Text+'k';

Memol.Text :=Memol.Text+'ka';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Aksara_Carakan_Tombol_DaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=Aksara_dJawa.Text+'f';

Memol.Text:=Memol.Text+'da';

end;

procedure TForm Konversi_Aksara_Jawa_Latin.Aksara_Carakan_Tombol_TaClick(
Sender: TObject):

begin

Rksara_Jawa.Text:=Aksara_Jawa.Text+'t';

Memol.Text:=Memol.Text+'ta';

end;

procedure TForm_ Konversi_Aksara_Jawa_Latin.Aksara_Carakan_Tombol_SaClick({
Sender: TObject);

begin

Aksara_Jawa.Text:=Aksara_Jawa.Text+'s';

Memol.Text:=Memol.Text+'sa';

end;

procedure TForm Konversi_Aksara_Jawa_Latin.Aksara_Carakan_Tombol_WaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=Aksara_dJdawa.Text+'w';

Memol.Text:=Memol.Text+'wa';

end;

procedure TForm_Konversi_Aksara_ Jawa_Latin.Aksara_Carakan_Tombol_LaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=pksara_Jawa.Text+'l';

Memol.Text:=Memol.Text+'la';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Aksara_Carakan_Tombol_ PaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=Rksara_Jawa.Text+'p';

Memol.Text:=Memol.Text+'pa';

end;




procedure TForm Konversi_Rksara_Jawa_Latin.Rksara_Carakan_Tombol_ DhaClick(
Sender: TObject):;

begin

Rksara_Jawa.Text:=RAksara_Jawa.Text+'d';

Memol.Text:=Memol.Text+'dha’;

end;

procedure TForm_Konversi_Aksara_Jawa_latin.Rksara_Carakan_Tombol_JaClick(
Sender: TObject):;

begin

Aksara_Jawa.Text:=Aksara_Jawa.Text+'j’';

Memol.Text:=Memol.Text+'ja';

end;

procedure TForm_Konversi_ Aksara_Jawa_Latin.Aksara_Carakan_Tombol_YaClick(
Sender: TObject):

begin

Bksara_dJawa.Text:=Aksara_Jawa.Text+'y';

Memol.Text:=Memol.Text+'ya';

end;

procedure TForm_Konversi Aksara_ Jawa_Latin.Aksara_Carakan_Tombol_NyaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=Aksara_Jawa.Text+'v’;

Memol.Text:=Memol.Text+'nya’;

end;

procedure TForm_Konversi_Aksara_Jawa_latin.Aksara_Carakan_Tombol MaClick(
Sender: TObject):

begin

Rksara_UJawa.Text:=Rksara_ Jawa.Text+'m';

Memol.Text:=Memol.Text+'ma';

end;

procedure TForm_Konversi_ Aksara_Jawa_Latin.Aksara_Carakan_Tombol_GaClick(
Sender: TObject);

begin

Rksara_Jawa.Text:=Aksara_Jawa.Text+'g';

Memol.Text:=Memol.Text+'ga’';

end;

procedure TForm_Konversi Aksara_Jawa_Latin.Aksara_Carakan_Tombol_BaClick(
Sender: TObject);

begin

Rksara_Jawa.Text:=Aksara_Jawa.Text+'b';

Memol.Text:=Memol.Text+'ba';

end;

procedure TForm_Konversi_ Aksara_Jawa_Latin.Rksara_Carakan_Tombol_ThaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=Aksara_dJawa.Text+'q';

Memol.Text:=Memol.Text+'tha';

end;

procedure TForm Konversi_ Aksara_Jawa_latin.Aksara_Carakan_Tombol NgaClick(
Sender: TObject):;

begin

Aksara_Jawa.Text:=Aksara_Jawa.Text+'z';

Memol.Text:=Memol.Text+'nga’';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.KosongkanClick{Sender: TObject);
begin

Aksara_Jdawa.Clear;

Latin.Clear;

Memol.Clear;

end;

procedure TForm Konversi Aksara_Jawa_Latin.TerjemahkanClick(
Sender: TObject):

begin

Latin.Text:=Memol.Text;

end;

procedure TForm Konversi Aksara_Jawa_ Latin.FormCreate(Sender: TObject);
begin

Aksara_Jawa.ReadOnly:=True;

Latin.ReadOnly:=True;

Panel_Tambah_ee.Hide;

Panel_Tambah_o.Hide;

end;




procedure TForm Konversi_Aksara_Jawa_Latin.Pasangan_Tombol HaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0, length (Rksara_OJawa.Text))+'H';

Memol. Text.=copy(Mémol Text, 0,length(Memol.Text)-1)+'ha';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Pasangan_Tombol NaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=copy (Aksara_Jawa.Text,0,length(Aksara Jawa. Text))+'N';

Memol. Text*=copy(Memol Text, 0, length(Memol.Text)-1)+'na';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Pasangan_Tombol_CaClick(
Sender: TObject):;

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)}+'C';

Memol . Text:=copy(Memol.Text, 0, length(Memol.Text)-1)+'ca’';

end;

procedure TForm Konversi_Aksara_Jawa_Latin.Pasangan_Tombol_RaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'R';

Memol.Text:=copy (Memol.Text, 0, length(Memol.Text)-1)+'ra‘;

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Pasangan_Tombol_KaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=copy (Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'K';

Memol.Text:=copy(Memol.Text, 0, length(Memol.Text)-1)+'ka';

end;

procedure TForm Konversi_ Pksara_Jawa_Latin.Pasangan_Tombol DaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'F';

Memol.Text :=copy (Memol.Text, 0, length (Memol.Text)-1)+'da’;

end;

procedure TForm Konversi_ Aksara_Jawa_Latin.Pasangan Tombol_TaClick(
Sender: TObject):;

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'T';

Memol.Text:=copy(Memol.Text,0,length(Memol.Text)-1)+'ta';

end;

procedure TForm Konversi_Aksara_Jawa_Latin.Pasangan_Tombol_SaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'S';

Memol.Text:=copy(Memol.Text, 0, length(Memol.Text)~-1)+"'sa’;

end;

procedure TForm Konversi_ Aksara_Jawa_Latin.Pasangan_Tombol_WaClick(
Sender: TObject)’

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'W';

Memol.Text:=copy (Memol.Text, 0, length(Memol.Text)-1)+'wa';

end;

procedure TForm Konversi_Aksara_Jawa_Latin.Pasangan_Tombol_LaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=copy(Aksara_dJawa.Text,0,length(Aksara Jawa.Text))+'L';

Memol. Text:=copy(Memol Text, 0, length (Memol.Text)-1)+'la';

end;

procedure TForm_Konversi_Aksara_dJdawa_Latin.Pasangan_ Tombol_PaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'P';

Memol.Text:=copy(Memol.Text, 0, length(Memol.Text)~-1)+'pa’';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Pasangan_Tombol DhaClick(
Sender: TObject):

begin

Aksara_dJdawa.Text:=copy (Aksara_Jawa.Text,0, length(Aksara Jawa.Text))+'D';

Memol.Text:=copy(Memol.Text, 0, length(Memol.Text)-1)+'dha’';

end;




procedure TForm Konversi_ Aksara_Jawa_lLatin.Pasangan_Tombol_JaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:wcopy(Aksara_Jawa.Text,O,length(Aksara_qawa.Text))+'J';

Memol.Text:=copy(Memol.Text, 0, length(Memol.Text)-1)+'ja';

end;

procedure TForm_Konversi_Aksara Jawa_Latin.Pasangan_Tombol_YaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+‘Y';

Memol.Text:=copy(Memol.Text, 0, length(Memol.Text)-1)+'ya';

end;

procedure TForm_Konversi Aksara_Jawa_Latin.Pasangan_Tombol_NyaClick(
Sender: TObject):;

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))}+'V';

Memol.Text:=copy(Memol.Text, 0, length(Memol.Text)-1)+'nya';

end;

procedure TForm Konversi_Rksara_Jawa_Latin.Pasangan_Tombol_MaClick{(
Sender: TObject):

begin

RAksara_Jawa.Text:=copy(Aksara_ Jawa.Text,0,length(Aksara_Jdawa.Text))+'M';

Memol.Text: =copy (Memol.Text, 0, length (Memol.Text)~1}+'ma’';

end;

procedure TForm Konversi_ Aksara_Jawa_Latin.Pasangan_Tombol_GaClick(
Sender: TObject):

begin

Rksara_Jawa.Text:=copy (Aksara_Jawa.Text,0,length(Aksara_Jawa.Text)}+'G';

Memol.Text:=copy (Memol.Text,0,length(Memol.Text)-1)+'ga';

end;

procedure TForm Konversi_ Aksara_Jawa_Latin.Pasangan_Tombol_ BaClick(
Sender: TObject):

begin

Rksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jdawa. Text))+'B';

Memol.Text:=copy (Memol.Text, 0, length (Memol.Text)-1)+'ba’;

end;

procedure TForm_Konversi_Rksara_Jawa_Latin.Pasangan_Tombol_ ThaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=copy(Rksara_Jawa.Text, 0, length(Aksara_Jawa.Text)}+'Q';

Memol .Text:=copy(Memol.Text, 0, length(Memol.Text)-1)+'tha';

end;

procedure TForm Konversi_Aksara_ Jawa_Latin.Pasangan_Tombol_NgaClick(
Sender: TObject):;

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length(Aksara_Jawa.Text))+'2';

Memol.Text:=copy (Memol.Text, 0, length(Memol.Text)-1)+'nga';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Aksara_Swara_Tombol AClick(
Sender: TObject):;

begin

Rksara_Jawa.Text:=Rksara_ Jawa.Text+'A’;

Memol.Text:=Memol.Text+'A';

end;

procedure TForm_Konversi_ Aksara_Jawa_Latin.Aksara_Swara_Tombol_ IClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=Rksara_Jawa.Text+'I';

Memol.Text:=Memol.Text+'I'; end;

procedure TForm Konversi Aksara_Jawa_Latin.Aksara_Swara_Tombol UClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=pksara_Jawa.Text+'U’';

Memol.Text:=Memol.Text+'U’';

end;

procedure TForm Konversi_Aksara_Jawa_latin.Aksara_Swara_Tombol EClick(
Sender: TObject);

begin

Aksara Jawa.Text:=RAksara_dJdawa.Text+'E';

Memol.Text:=Memol.Text+'E"';

end;




procedure TForm Konversi_Aksara_Jawa_Latin.Aksara_Swara_Tombol OClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=Rksara_Jawa.Text+'0';

Memol.Text:=Memol.Text+'0’';

end;

procedure TForm_Konversi_Rksara_Jawa_Latin.Aksara_Rekan_Tombol_KhaClick(
Sender: TObject):

begin

Rksara_vJgawa.Text:=Aksara_dJdawa.Text+'k+';

Memol.Text:=Memol.Text+'kha';

end;

procedure TForm Konversi_Aksara_Jawa_Latin.Aksara_Rekan_Tombol VaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=Aksara_dJawa.Text+'p+':

Memol.Text:=Memol.Text+'fa';

end;

procedure TForm_ Konversi_Aksara_Jawa_Latin.Aksara_Rekan_Tombol_DzaClick(
Sender: TObject):

begin

Rksara_ Jawa.Text:=pksara_Jawa.Text+'f+';

Memol.Text:=Memol.Text+'dza';

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Aksara_Rekan_Tombol_GhaClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=Aksara_Jawa.Text+'g+';

Memol.Text:=Memol.Text+'gha';

end;

procedure TForm Konversi Aksara Jawa_Latin.Aksara_Rekan_Tombol_ZaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=Aksara_dJdawa.Text+'j+';

Memol.Text:=Memol.Text+'za';

end;

procedure TForm_Konversi_Aksara_Jdawa_Latin.Wilangan_Tombol_ 1Click(
Sender: TObject);

begin

Aksara_Jawa.Text:=Rksara_Jawa.Text+'l’;

Memol.Text:=Memol.Text+'l’;

end;

procedure TForm Konversi_ Aksara_Jawa_Latin.Wilangan_Tombol_2Click(
Sender: TObject);

begin

Aksara_UJawa.Text:=pksara_Jawa,Text+'2';

Memol.Text:=Memol.Text+'2';

end;

procedure TForm_Konversi_Aksara_Jawa_latin.Wilangan_ Tombol_3Click(
Sender: TObject);

begin

Aksara_Jawa.Text:=Aksara_Jawa.Text+'3';

Memol .Text:=Memol.Text+'3';

end;

procedure TForm Konversi_ Aksara_Jawa_Latin.Wilangan_Tombol 4Click(
Sender: TObject);

begin

Aksara_Jawa.Text:=RAksara Jawa.Text+'4';

Memol.Text:=Memol.Text+'4'; end;

procedure TForm_Konversi Aksara_Jdawa_Latin.Wilangan Tombol 5Click(
Sender: TObject):

begin

Aksara_Jawa.Text:=Rksara_Jdawa.Text+'5';

Memol.Text:=Memol.Text+'5"';

end;

procedure TForm_Konversi Aksara_Jawa_Latin.Wilangan Tombol_6Click(
Sender: TObject);

begin

Aksara Jawa.Text:=Rksara_Jawa.Text+'6';

Memol.Text:=Memol.Text+'6"';

end;




procedure TForm_Konversi_Aksara_Jawa_Latin.Sandhangan_Tombol titikClick(
Sender: TObject):;

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,length(Aksara_Jawa.Text))+'.’;

Memol.Text:=copy (Memol.Text, 0, length(Memol.Text))+'.";

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Sandhangan_Tombol komaClick(
Sender: TObject);

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text,0,1ength(Aksara_Jawa.Text))+',‘:

Memol.Text:=copy (Memol.Text, 0, length(Memol.Text))+',"':

end;

procedure TForm_Konversi_Aksara_Jawa_Latin.Sandhangan_Tombol_pangkonClick(
Sender: TObject):

begin

Aksara_Jawa.Text:=copy(Aksara_Jawa.Text, 0, length{Aksara_Jawa.Text))+'\';

Memol.Text :=copy(Memol.Text, 0, length(Memol.Text)-1);

end;

end.

Halaman Latihan Aksara Jawa
unit F_Latihan_A C:
interface

uses
windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, ExtCtrls, OleCtrls, ShockwaveFlashObjects_TLB, StdCtrls, Menus;

type
TForm_Latihan_Aksara_Carakan = class(TForm)

Latihan: TLabel:
Exit: TLabel;
background: TImage:
Pemula: TLabel;
Menengah: TLabel;
Mahir: TLabel;
Animasi_Soal_ Pemula: TShockwaveFlash;
Animasi_Soal_Menengah: TShockwaveFlash;
Animasi_Soal Mahir: TShockwaveFlash;
PopupMenul: TPopupMenu;
APLIKASIl: TMenultem;
PEMBELAJARANAKSARAJAWALl: TMenultem;
BERBASISMULTIMEDIAl: TMenultem;
WendiAfriantol: TMenultem;
NO07125731: TMenultem;
Copyright201120121: TMenultem;
procedure ExitClick(Sender: TObject):
procedure FormCreate(Sender: TObject):
procedure PemulaClick(Sender: TObject);:
procedure MenengahClick(Sender: TObject):
procedure MahirClick(Sender: TObject):

private
{ Private declarations }
public
{ Public declarations )}
end;
var

Form_Latihan_Aksara_Carakan: TForm Latihan_Aksara_Carakan;

implementation

uses F_Menu;

(SR *.dfm)

procedure TForm_Latihan Aksara_Carakan.ExitClick(Sender: TObject):
begin

Animasi_Soal_Pemula.Hide;

Animasi_Soal_Menengah.Hide;

Animasi_Soal_Mahir.Hide;

Menu_Utama.Enabled:=True;

Menu_Utama.SetFocus;

end;

procedure TForm_Latihan Aksara_ Carakan.FormCreate(Sender: TObject);
begin

Animasi_Soal_Pemula.Hide;

Animasi_Soal_Menengah.Hide;

Animasi_Soal_Mahir.Hide;

end;
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procedure TForm Latihan_Rksara_Carakan.PemulaClick(Sender: TObject);
begin

Animasi_Soal_Pemula.Show;

With Animasi_Soal_ Pemula do

begin

Movie := ExtractFilePath(Application.ExeName)+'\Animasi\Latihan\Aksara Carakan\Soal
Pemula.swf';

end;

Animasi_Soal_Menengah.Hide;

Animasi_Soal Mahir.Hide;

end;

procedure TForm_Latihan_Aksara_Carakan.MenengahClick(Sender: TObject);
begin

Animasi_Soal_Menengah.Show;

With Animasi_Soal_Menengah do

begin

Movie := ExtractFilePath(Application.ExeName)+'\Animasi\Latihan\Aksara Carakan\Soal
Menengah.swf';

end;

Animasi_Soal_Pemula.Hide;

Animasi_Soal Mahir.Hide;

end;

procedure TForm_Latihan_Aksara_Carakan.MahirClick(Sender: TObject);
begin

Animasi_Soal_Mahir.Show;

With Animasi_Soal_ Mahir do

begin

Movie := ExtractFilePath(Application.ExeName)+'\Animasi\Latihan\Aksara Carakan\Soal
Mahir.swf';

end;

Animasi_Soal_Menengah.Hide;

Animasi_Soal_Pemula.Hide;

end;

end.

Halaman Tes Aksara Jawa

unit F_Latihan_Pemula;
interface

uses
windows, Messages, SysUtils, Variants, Classes, Graphics, Controls, Forms,
Dialogs, ExtCtrls, OleCtrls, ShockwaveFlashObjects_ TLB, StdCtrls, Menus;

type
TForm_Tes_Pemula = class(TForm)

Background: TImage;
Tes_Pemula: TLabel;
Animasi_Soal: TShockwaveFlash;
Exit: TLabel;
PopupMenul: TPopupMenu;
APLIKASIl: TMenultem;
PEMBELAJARANAKSARAJAWAL: TMenultem;
BERBASISMULTIMEDIAl: TMenultem;
WendiAfriantol: TMenultem:;
N07125731: TMenultem;
Copyright201120121: TMenultem;
procedure FormCreate(Sender: TObject):
procedure ExitClick(Sender: TObject):

private
{ Private declarations }
public
{ Public declarations }
end;
var

Form_Tes_Pemula: TForm_Tes_Pemula;
implementation
uses F_Menu;
{$R *.dfm}
procedure TForm Tes_Pemula.FormCreate(Sender: TObject);
begin
Animasi_sSoal.Show;

With Animasi_Soal do
begin




Movie := ExtractFilePath(Application.ExeName)+'Animasi\Tes\Soal Pemula.swf';
Visible := True;
N end;

wtf end;

procedure TForm_Tes_Pemula.ExitClick(Sender: TObject);
begin

Close;

Animasi Soal.Stop;

Animasi_Soal.GotoFrame (0);

Menu_Utama.Enabled:=True;

i Menu_Utama.SetFocus;

i end;

end.




